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1. INTRODUCTION

The Carbon Accounting Model for Forests (CAMFor)
is a model developed for the Australian Greenhouse
Office (AGO) for tracking the carbon associated with
a stand of trees. CAMFor Estate is a related model
that allows for the summing of estates (composites of
different stand types) and for the derivation of a
carbon ledger across a composite of estates.

CAMFor calculates the carbon flows associated with
a stand of trees, including the wood products made
from wood harvested from that stand. It calculates
the carbon in the various tree, debris, soil and
product components, and the carbon exchanged with
the atmosphere, for several hundred years - through
thinnings, multiple rotations, and fires.

1.1 CREDITS
This spreadsheet finds its conceptual foundations in
a public domain FORTRAN program called ‘CO2Fix’,
published in October 1990 by Frits Mohren, Kees
Klein Goldewik, “De Dorrchamp”, Wageningen. 

The model expressed by this workbook was
enhanced by Dr Gary Richards (02 6274 1926 or 
+612 6274 1926, gary.richards@greenhouse.gov.au) of
the Australian Greenhouse Office, GPO Box 621,
Canberra ACT 2601 Australia. 

The model was compiled by Dr David Evans,
Science Speak

This user manual was prepared by Jeremy Alcorn of
Spatial Vision Innovations Pty Ltd.

National Carbon Accounting System Technical Report 1
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1.2 LICENCE AGREEMENT
IMPORTANT: YOU MUST READ THE LICENCE
CONDITIONS BEFORE USING THIS WORKBOOK.

Licence Conditions Relating to CAMFor Software

1. IMPORTANT:

THESE CONDITIONS REPRESENT A LEGAL
AGREEMENT (“the Agreement”) BETWEEN THE
AUSTRALIAN GREENHOUSE OFFICE (“AGO”)
AND YOU (“the Licensee”) IN RELATION TO THE
CAMFor SOFTWARE DOWNLOADED BY YOU
(“CAMFor”). BY CLICKING ON THE “I AGREE”
BUTTON THAT INITIATES THE DOWNLOAD
YOU INDICATE YOUR ACCEPTANCE OF THE
LICENCE CONDITIONS (“the Conditions”).
(from the Australian Greenhouse Office website
http://www.greenhouse.gov.au/ncas/files/
consultancies/tool.html)

2. Duration

2.1 The Agreement commences when you click
on the “I Agree” button to initiate the
download, and continues in force
indefinitely unless terminated in accordance
with Condition 11.

3. Licence

3.1 AGO grants to the Licensee a non-exclusive,
non-transferable licence:

(a) to use, reproduce, and Commercialise
CAMFor in unaltered form (except for
changes to the ‘Stand Inputs’ and ‘Species
Inputs’ worksheets); and

(b) subject to Condition 7, to adapt CAMFor

and/or develop derivative products and to
Commercialise those adapted or derivative
products.

3.2 AGO warrants that the grant of the Licence
does not infringe the intellectual property
rights of any person.

4. Intellectual Property Rights

4.1 All rights not expressly granted to the
Licensee under Condition 3 are reserved.

4.2 The Licensee acknowledges that CAMFor is
a special, unique and valuable product in
which the copyright vests in the AGO.

4.3 The AGO retains ownership of copyright in
CAMFor in its original form.

4.4 Subject to clause 4.3, copyright in any
Derivative product of CAMFor made under
clause 7 vests in the Licensee or as it might
arrange.

4.5 The Licensee acknowledges that all trade
mark and analogous rights in the name
“CAMFor” vest in the AGO.

5. Custody of CAMFor

5.1 The Licensee shall maintain CAMFor in safe
custody.

5.2 The Licensee shall take all reasonable steps
to ensure that any person given access to
CAMFor is aware of these Conditions and
uses CAMFor only in accordance with the
Agreement.

6. Commercialisation of CAMFor in

Unaltered Form

6.1 The Licensee may Commercialise CAMFor

in unaltered form in accordance with this
clause.

6.2 The Licensee shall not remove, obscure or
interfere with any copyright notice,
trademark, warning or disclaimer affixed to,
incorporated in or otherwise applied in
connection with CAMFor.

6.3 Any agreement under which CAMFor is
supplied, sub-licensed or Commercialised to
any third party shall incorporate a
notification of precautions substantially
identical to that set out in clause 8.
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7. Commercialisation of Adaptations or

Derivative Products

7.1 The Licensee may Commercialise CAMFor in
an adapted form, or a product derived from
or incorporating CAMFor, (“the Derivative”),
but only in accordance with this clause.

7.2 The Licensee shall remove from the
Derivative all copyright notices and
trademarks affixed to, incorporated in or
otherwise applied in connection with
CAMFor.

7.3 The Derivative may not be Commercialised
under the name “CAMFor”.

7.4 Except where expressly agreed, the Licensee
shall not represent to anyone that the
Derivative has been approved or endorsed
by AGO or the Commonwealth.

8. IMPORTANT PRECAUTIONS

8.1 The AGO does not guarantee that CAMFor is
suited to all site and management
conditions. Suitability is a matter for
determination by the Licensee.

8.2 The AGO cannot guarantee that CAMFor is
free from errors, and does not warrant the
quality, performance or suitability of
CAMFor for any purpose.

8.3 The Licensee assumes responsibility for
selection of CAMFor to achieve any intended
results, and for its installation and use.

8.4 The Licensee assumes responsibility for the
interpretation of any results obtained from
use of CAMFor, and must exercise all
appropriate precautions before placing
reliance on those results.

9. RELEASE

9.1 The Licensee releases the AGO, the
Commonwealth and their employees and
agents in respect of all liability for loss,
damage or injury which may be suffered by
it arising from the Licensee’s use or
Commercialisation of CAMFor or a
Derivative.

10. INDEMNITY

10.1 The Licensee indemnifies the AGO, the
Commonwealth and their employees and
agents in respect of all liability for loss,
damage or injury, which may be suffered
by any person arising from the Licensee’s
Commercialisation of CAMFor or a
Derivative.

11. Termination

11.1 If the Licensee breaches any of these
Conditions, the AGO may terminate the
Agreement immediately by notice in
writing to the Licensee.

11.2 The termination of the Agreement under
Condition 11.1 shall be without prejudice to
the rights of either party accrued under the
Agreement prior to termination.

11.3 The Licensee shall cease using CAMFor for
any purpose from the date of termination of
the Agreement and shall return CAMFor

and any copies made of it to the AGO
within 30 days of the date of termination.

12. Additional Clauses

12.1 The Agreement supersedes all prior
agreements and understandings between
the parties relating to CAMFor and
constitutes the entire agreement between
the parties.



2. CAMFOR AND CAMFOR ESTATE

The Carbon Accounting Model for Forests
comprises two EXCEL Workbooks: CAMFor and
CAMFor Estate. The CAMFor workbook allows you
to enter parameters for a single species and
management regime. The CAMFor Estate workbook
enables you to combine the carbon mass results of
one or more of these CAMFor workbooks into a
single carbon mass result, and can also combine the
carbon mass results of CAMFor Estate workbooks.

2.1 CAMFOR WORKBOOK
The CAMFor model is implemented in this
spreadsheet. This workbook (designed to be read in
conjunction with the associated Excel file)
implements the CAMFor model for one species and
one management regime. You will need a separate
workbook for each combination of management
regime and species.

Each workbook contains several sheets. The sheets
are listed as tabs at the bottom of the workbook.
Each workbook is independent of any other
workbook or file (that is, it does not get any
information by ‘linking’ to any other workbook).
This workbook has several inputs:

1. The stand and management descriptions,
and information about the authorities and
assumptions used can be recorded in the
‘Descrip’ sheet.

2. General information about the management
regime, which you enter in the ‘In-General’
sheet.

3. Information about the thinning regime,
which you enter in the ‘In-Thin’ sheet.

4. Information about the timing and impact of
fires, which you enter in the ‘In-Fire’ sheet.

5. Information about the species of tree, which
you enter in the ‘In-Species’ sheet.

12.2 No addition to or modification of any
provision of the Agreement shall be binding
unless in writing signed by both parties.

12.3 The Agreement shall be governed by and
construed in accordance with the laws for
the time being in force in the Australian
Capital Territory.

12.4 No forbearance, delay or indulgence by a
party in enforcing the provisions of the
Agreement shall prejudice or restrict the
rights of that party, nor shall waiver of
those rights operate as a waiver of any
subsequent breach.

12.5 Any reading down or severance of a
particular provision does not affect the
remaining provisions of the Agreement.

13. Definitions

13.1 In these Conditions, unless the contrary
intention appears:

“AGO” means the Australian Greenhouse
Office, and includes any agency which
succeeds to the functions of that agency.

“Commercialise” includes communicating,
distributing, giving away, selling, letting for
hire, or by way of trade, offering or
exposing for sale or hire any article
embodying a product, and sub-licensing of
intellectual property rights in that product
to the extent necessary for the ordinary use
of the product.

“CAMFor” means the CAMFor stand-based
carbon assessment model which is licensed
under these conditions.

“Derivative” means an adapted form, or a
product derived from or incorporating
CAMFor, made pursuant to clause 7.

“Licence” means the licence referred to in
Condition 3.

Australian Greenhouse Office4



The simplest way to create a new CAMFor

workbook is to make a copy of a given CAMFor

workbook file then enter the appropriate species
and management regime data (that is, clone and
modify a CAMFor workbook).

On the input sheets, only enter data in cells that
have a light blue background (see the Key). If you
change a cell to an obviously illegal value, it or a
nearby cell will light up in bright red - so change it
(or an associated cell, such as another fraction that
should sum with the cell you just changed to one) to
something sensible.

Names of quantities, noted in dark green, are used
to refer to that quantity elsewhere in the
spreadsheet. The naming system is used to make
this workbook easily-readable. (See ‘Name:Define’
in the ‘Insert’ menu but do not change anything in
here!).

2.2 CAMFOR ESTATE WORKBOOKS
Use a CAMForEstate workbook to combine the
results of one or more CAMFor workbooks, or
existing CAMFor Estate workbooks into a single
carbon mass result. This allows you to calculate
carbon masses for an estate (and across estates)
containing mixed management regimes and species.

National Carbon Accounting System Technical Report 5

6. Information about the growth rates and
distribution of growth, which you enter in
the ‘In-Growth’ sheet.

7. Information about the age and area of stands
of this type can be entered in the ‘Group’
sheet. 

The workbook calculations occur immediately, so
once you have entered the appropriate information
in the input sheets you may go to the output sheets
and view the results.

- After you have entered information in the
‘Input’ and ‘Group’ sheets the output is in
the ‘Calc-Prelim’ and ‘Calc-Sim’ sheets (lots
of numbers) and the ‘Out-Graph’ sheet
(a graph of the carbon per hectare in each
year). 

- After you have entered information in these
input sheets, carbon masses are presented
for the ‘typical’ stand in the ‘Out-Sim’ and
‘Out-Graph’ sheets. Carbon masses for all
stands of the type are presented, the total
stock ‘Group CM Totals’ and carbon
increments in the ‘Group CM Increments’
sheets.

In a given CAMFor workbook, you can copy input
data from other CAMFor workbooks that have the
same type of management regime and species:

- DO NOT copy in whole sheets (you will
confuse the naming system that this
workbook uses to communicate data
between sheets)

- DO copy and paste the values of individual
cells or arrays of cells. 
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3. HOW TO USE CAMFOR

This file is an Excel ‘workbook’. This workbook
consists of several spreadsheets (‘sheets’), which are
described in the next section. This workbook is
independent of any other workbook or file (that is,
it does not get any information by ‘linking’ to any
other workbook or file). 

There are several types of sheets:

1. Input sheets. Names start with ‘In-’. You
enter data on these sheets.

2. Calculation sheets. Names start with ‘Calc-’.
All the calculations are in formulae in the
cells in these sheets. Do not enter data on
these sheets.

3. Output sheets. Names start with ‘Out-’.
Where you can view the results of the
calculations. Do not enter data on these
sheets.

4. Stand aggregation sheets. Names start with
‘Stand’. Sheets for specifying stands with
the same input data as in this workbook,
and finding the combined carbon masses of
this group of stands. You enter some data on
these sheets.

5. Other sheets. Documentation and
explanations mainly.

Go to the input sheets and enter numbers in the
light-blue cells (and only the light blue cells - see the
‘Key’ on this sheet). The workbook (almost) instantly
calculates the results as you enter the data, so when
you have finished entering the data the results will
be waiting for you. The simulation results are in the
‘Out-Sim’ and the ‘Out-Graph’ sheets (and if you
want more details, see the ‘Calc-Sim’ sheet). The
‘Out-Sim’ sheet is designed to be printed out, the
graphs may be printed out, and any sheet can be
printed out (although the ‘Calc-’ sheets may not fit
on single pages).

This workbook implements the CAMFor model for
one set of inputs (the data entered in the ‘In-’
sheets). You will need a separate workbook for each
different combination of inputs. Enter a set of inputs
in one workbook, and if you wish to keep that set of
inputs then save the workbook. Then, to do another
combination of inputs, copy the first workbook file
and enter the new inputs in the second workbook
(that is, clone and modify). Always keep a copy of
this original workbook, in case some accident befalls
your working copies.

You can copy and paste input data between
workbooks, but we STRONGLY URGE you to only
paste using ‘Paste Special’ choice on the ‘Edit’ menu
(then choose Paste ‘Values’ and Operations ‘None’).
Pasting normally can foul up the system of named
cells in this workbook. If you ever open this
workbook and Excel asks you whether you want to
‘update’ or mentions ‘links’ or ‘linking’ then the
naming system has been corrupted by pasting
something in normally from another workbook - just
start from the original workbook, copy in your input
data by pasting by value, and trash the corrupted
workbook.

Use a CAMForEstate workbook to combine the
carbon mass results of one or more of these CAMFor

workbooks and several CAMFor Estate workbooks
into a single carbon mass result (this workbook
becomes a linked input into the CAMFor Estate

workbook). This allows you to calculate carbon
masses for an estate containing mixed management
regimes and species. 

Try opening this workbook in two windows at once
(choose ‘New Window’ from the ‘Window’ menu).
You can then look at two sheets at once. Open the
‘Out-Graph’ sheet and an input sheet. When you
change an input cell the graph is immediately
recalculated, so you see the effect on the simulation
of changing that input almost immediately. This
technique is most beneficial when you have two
computer screens (somewhat problematic on
computers running Windows; Macs handle two
screens at once simply and reliably).
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3.1 CAMFOR SHEETS
The CAMFor ‘workbook’ consists of about a dozen ‘spreadsheets’ (or ‘sheets’). Each sheet has a
corresponding ‘tab’ near the bottom of the window. Click on the tab to display the sheet. 

The next five tabs are for inputting data on which the Carbon Mass totals will be calculated

Intro 
Describes purpose of CAMFor,
development credits and licence
conditions.

Descrip
Fields for entering descriptive
text for a stand including a
description of the stand,
management regime of the
stand and any authorities and
assumptions.

Use
Describes how to fill in the
workbook. Also describes which
fields may be filled and which
are protected. 

Doc 1
Documents how to treat the
issues of uneven aged forests,
mixed species and fire within
stands.

Doc2
Documents the definitions and
names used in CAMFor.

Doc 3
Describes how quantities are
calculated. 

Diagrams
Shows how the model works. 

In-General
Enter general information about
the stands in this workbook.

In-Thin
Enter information about any
thinning of the stands by people.

In-Fire
Enter information about any fires
that occur in the stands in this
workbook.

In-Species
Enter information about the
species of tree in the stands in
this workbook.

In-Growth
Enter information about the
growth rate of the species of
tree in the stands in this
workbook.
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The next five tabs are for displaying outputs from CAMFor.

3.2 DESCRIPTION SHEET 
Enter your descriptions of what you are doing in this workbook, for your own record keeping. Nothing
you do in this sheet effects any calculations. Feel free to move these text boxes around and change their
sizes or headings. 

Description

Stand Description

Enter your description here. 

Enter your descriptions of what you are doing in this workbook, for your own record keeping. Nothing you do in this 
sheet effects any calculations. Feel free to move these text boxes around and change their sizes or headings.

Authorities and Assumptions

Enter your authorities and assumptions here. 

Management Description

Example: Imposed management regime number 3 for species X and site index Y from the ZZZ management and 
silvicultural regimes.

Calc Prelim 
Computes quantities required by
the main simulation calculations.

Out Sim 
For printing out the simulation
results.

Group 
For entering information about a
group of stands.

Group CM Increments 
Carbon mass increments of the
group of stands are calculated.

Calc Sim 
Simulates the stand 
year-by year.

Out Graph 
This sheet graphs some
simulation outputs from the
‘Calc-Sim’ sheet.

Group CM Totals 
Carbon mass totals of a group of
stands are calculated

Management description
Enter a text description of the management regime
for this particular stand.

Authorities and Assumptions
Enter a text description of the authorities and
assumptions used for this stand.

Stand description
Enter a text description of the stand.
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This is the sheet where you enter management information for the stands in the workbook.

There are five sheets for entering data (Input or ‘In’-sheets);

1. In-General. Enter general information about the stands in this workbook.

2. In-Thin. Enter information about any thinning of the stands by people.

3. In-Fire. Enter information about any fires that occur in the stands in this workbook.

4. In-Species. Enter information about the species of tree in the stands in this workbook.

5. In-Growth. Enter information about the growth rate of the species of tree in the stands in this
workbook.

Only enter data in cells coloured light blue. If a cell becomes bright red then there is a problem with the data
you have entered.

3.3 IN-GENERAL SHEET

This sheet is for entering general information about the stands in the workbook.

3.3.1 Stand Description
Box for entering a description of the stand in this worksheet. This box is optional and data entered here will
not appear in any calculations. 

Stand Description
Name Example Stand

Notes This input data is purely for illustrating how CAMFor works. 
Any resemblance to any real stand is purely accidental. 

Input 1/5: General

Management
Name Description Value Units
ManagedText Stand ’Managed’ (managed and thinned by people) or ’Natural’ Managed -

3.3.2 Management 
Table for entering whether the stand is managed and thinned by people or is left alone and natural.
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3.3.3 Site 

3.3.4 Timing and Initial Conditions 
If the stand is never cleared then there is only one rotation and so the rotation length is huge (enter
1,000 years perhaps).

Site
Name Description Value Units
Growth Relative to Standard Site
SiteAdjustStem Stem-growth site adjustment 1.05 -
SiteAdjustBran Branch-growth site adjustment 0.95 -
SiteAdjustBark Bark-growth site adjustment 1.10 -
SiteAdjustLeaf Leaf and twig-growth site adjustment 1.20 -
SiteAdjustCRot Coarse-root-growth site adjustment 0.90 -
SiteAdjustFRot Fine-root-growth site adjustment 0.95 -

Timing and Initial Conditions
Name Description Value Units
Timing (only relevant if the stand is ’Managed’)
RotLen Rotation length (time from planting to final 100% thin) 3 0 y
RotAgeInit Age of rotation at start of simulation 3 y
Initial Tree Components
StemVolInit Initial volume of stems 7.00 m3 / ha
BranMInit Initial mass of branches 4.00 t / ha
BarkMInit Initial mass of bark 1.00 t / ha
LeafMInit Initial mass of leaves and twigs 5.00 t / ha
CRootMInit Initial mass of coarse roots 3.00 t / ha
FRootMInit Initial mass of fine roots 2.00 t / ha
Initial Debris Components
DeFDcyCMInit Initial carbon mass of decomposable fine decay 1.00 t / ha
ReFDcyCMInit Initial carbon mass of resistant fine decay 2.00 t / ha
DeCDcyCMInit Initial carbon mass of decomposable coarse decay 3.00 t / ha
ReCDcyCMInit Initial carbon mass of resistant coarse decay 4.00 t / ha
DeLLitCMInit Initial carbon mass of decomposable leaf litter 5.00 t / ha
ReLLitCMInit Initial carbon mass of resistant leaf litter 6.00 t / ha
DeBLitCMInit Initial carbon mass of decomposable bark litter 7.00 t / ha
ReBLitCMInit Initial carbon mass of resistant bark litter 8.00 t / ha
DeDwdCMInit Initial carbon mass of decomposable deadwood 9.00 t / ha
ReDwdCMInit Initial carbon mass of resistant deadwood 12.00 t / ha
Initial Soil Components
ActvCMInit Initial carbon mass of active pool 12.00 t / ha
InrtCMInit Initial carbon mass of inert pool 43.00 t / ha
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3.3.6 Soil Carbon 
You may wish to externally generate your soil carbon mass data. If so, this is where you enter that data.

If you set the ‘Soil Carbon Source’ to 1 then CAMFor calculates the soil carbon mass according to the
CAMFor model and the data in the ‘Soil Carbon’ table is ignored.

If you set the ‘Soil Carbon Source’ to 2 then CAMFor copies the data in the ‘Soil Carbon’ table into the soil
carbon mass column in the ‘Main’ sheet, thereby replacing the soil carbon mass that CAMFor calculates. In
this case CAMFor still goes ahead and calculates the masses of carbon in the active and inert pools - but it
ignores those calculations when it comes to computing the soil carbon mass because it gets the soil carbon
mass from the ‘Soil Carbon’ table instead. You should copy the data you have externally calculated for the
soil carbon mass into the ‘Soil Carbon’ table (use ‘Paste Special:By Value’ in the ‘Edit’ menu). The ‘Year’ in
the ‘Soil Carbon’ table is the number of years since the start of the simulation; year 0 is the initial condition.
You can extend the table as required (copy down the last row using ‘Fill:Down’ in the ‘Edit’ menu).

Note that externally calculated data may not reflect the thinning or fires that CAMFor knows about.

Relative Growth Adjustments allow for variation in biomass allocation within trees as affected by site
conditions. 

Initial Components refers to the carbon present at the site prior to the commencement of accounting, in effect,
the starting condition.

3.3.5 Soil Carbon Source
Choose the source for the soil carbon mass model.

Choose the source for the soil carbon mass data:
 1 = Let CAMFor calculate it
 2 = Use the data in the ’Soil Carbon’ table instead

<--- Enter ’1’ or ’2’

Soil Carbon
Source

SoilCMType
1

Soil Carbon
Year Soil Carbon

yr t / ha
SoilCMTbl

0 0.0
1 0.2
2 0.4
3 0.6
4 0.8
5 1.0
6 1.2
7 1.4
8 1.6
9 1.8

1 0 2.0
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Thinnings
Fractions of Thinned Stem Weight Allocated to Debris or Products Fractions of Thinned Branch Weight Allocated to Debris or Products Allocated Fractions of Thinned Bark

Rotation 
Age

Fraction of 
Trees 

Thinned
Dead-
wood

Bio-
Fuel Paper Packing Furn-iture

Fibre 
Board

Const-
ruction

Mill 
Residue

Row 
Sum

Dead-
wood

Bio-
Fuel Paper Packing Furn-iture

Fibre 
Board

Const-
ruction

Mill 
Residue

Row 
Sum Litter

Bio-
Fuel Paper

Mill 
Residue

Row 
Sum

Thin
Age

ThinFrac
Tbl

ThinStem
Dwd

ThinStem
Fuel

ThinStem
Papr

ThinStem
Pack

ThinStem
Furn

ThinStem
Fibr

ThinStem
Cons

ThinStem
Resi

ThinBran
Dwd

ThinBran
Fuel

ThinBran
Papr

ThinBran
Pack

ThinBran
Furn

ThinBran
Fibr

ThinBran
Cons

ThinBran
Resi

ThinBark
Lit

ThinBark
Fuel

ThinBark
Papr

ThinBark
Resi

Final 1.00 0.10 0.03 0.02 0.16 0.18 0.16 0.15 0.20 1.00 0.24 0.13 0.09 0.02 0.14 0.14 0.21 0.03 1.00 0.10 0.12 0.53 0.25 1.00
16 0.17 0.10 0.20 0.40 0.10 0.10 0.10 0.00 0.00 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
20 0.22 0.10 0.20 0.40 0.10 0.10 0.10 0.00 0.00 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
25 0.21 0.10 0.20 0.40 0.10 0.10 0.10 0.00 0.00 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00

125 0.18 0.10 0.20 0.40 0.10 0.10 0.10 0.00 0.00 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
130 0.17 0.10 0.20 0.40 0.10 0.10 0.10 0.00 0.00 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
145 0.15 0.10 0.20 0.40 0.10 0.10 0.10 0.00 0.00 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
150 0.13 0.10 0.20 0.10 0.10 0.10 0.10 0.20 0.10 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
155 0.11 0.10 0.20 0.10 0.10 0.10 0.10 0.20 0.10 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
160 0.10 0.10 0.20 0.10 0.10 0.10 0.10 0.20 0.10 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
165 0.08 0.10 0.20 0.10 0.10 0.10 0.10 0.20 0.10 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
170 0.07 0.10 0.20 0.10 0.10 0.10 0.10 0.20 0.10 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
175 0.06 0.10 0.20 0.10 0.10 0.10 0.10 0.20 0.10 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
180 0.05 0.10 0.20 0.10 0.10 0.10 0.10 0.20 0.10 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
185 0.04 0.10 0.20 0.10 0.10 0.10 0.10 0.20 0.10 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
190 0.04 0.10 0.20 0.10 0.10 0.10 0.10 0.20 0.10 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00
195 0.00 0.10 0.20 0.10 0.10 0.10 0.10 0.20 0.10 1.00 0.37 0.10 0.07 0.09 0.07 0.13 0.14 0.03 1.00 0.25 0.39 0.06 0.30 1.00

3.4 IN-THIN SHEET 

This sheet is where you enter information about any thinning of the stands by people. Only managed stands
are thinned; natural stands are instead self thinning (see the ‘TreeMortFrac’ in the species inputs). The
‘Thinnings’ table specifies the schedule for thinning the type of stand, and what the harvest material is
made into. 

3.4.1 How to Fill in the ‘In-Thin’ Sheet
Each row specifies one thinning, occurring at the ‘Rotation Age’ (the number of years since the rotation was
planted, whole numbers only, no more than one thinning per rotation age), and the ‘Fraction of Trees
Thinned’, in the proportions shown in the rest of the line. The thinning whose rotation age is ‘Final’ is for the
final thinning, a 100% thin that removes all of the trees and ends the rotation. The rows may be in any order,
except the ‘Final’ thin must be first. Each set of allocation fractions in a thin (such as the allocation fractions
of stem wood) must sum to 1 (the row sum turns red whenever they do not add to 1, which will happen as
you edit them - when you are finished no row sum should be red).

If there is no thinning, set all the rotation ages at which thinning occurs higher than the rotation length (so
the simulation never gets to those rotation ages), or delete the rows (but do not delete the first two rows,
because then you might not be able to recreate them if you need them later).

You can delete or copy any rows after the ‘Final’ row and the next row:

- For more rows: Select the last row and the blank rows below it that you want to contain new rows,
then choose ‘Fill:Down’ from the ‘Edit’ menu.

- To delete rows: Select any rows, except the ‘Final’ row and the one after, then choose ‘Delete’ from
the ‘Edit’ menu.

Sort the rows by selecting them (do NOT include the first row, that is, do not sort with the ‘final’ row) and by
choosing ‘Sort...’ from the ‘Data’ menu, then sorting by ‘ThinAge’ (col A).

2/5: ThinningsInput 
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3.5 IN-FIRE SHEET

Enter information about any fires that occur in the stands in this workbook. The Fire table specifies the fires
that occur in this type of stand. Each fire is specified as occurring at a stand age (such as 10 years after the
stand was first planted) rather than a specific year (such as 1985), so fires in CAMFor are treated as typical
events rather than as historical events.

Only enter data in the cells coloured light blue. If a cell becomes bright red then there is some problem with
the data you have entered. 

3.5.1 How to Fill in the ‘In-Fire’ Sheet
Each row specifies one fire, occurring at the ‘Stand Age’ (the number of years since the first rotation was
planted, whole numbers only, no more than one fire per age), and as described in the rest of the row. There
are two types of fires:

1. Stand replacing: Complete mortality. Trees and debris burn, and what remains of the tree is then
100% thinned by people (using the ‘Final’ row in the ‘Thinning’ table). Begin a new rotation
immediately.

2. Regenerating: No mortality. Either a ground or a crown-and-ground fire (a ground fire just burns the
debris; a crown-and-ground fire also burns the trees). Any burnt tree material (which should mainly
be leaves and twigs) is replaced immediately. Has no effect on age or growth. No thinning. 

See the diagrams for an exact specification of where all the material flows in a fire. If a fire occurs in the same
year as a thinning, then the thinning occurs first (so there’s not as much to go up in flames).

Fire

Year of 
Simulated 
Period in 

Which 
Fire 

Occurs 

Stand-Replacing 
or Regenerating 

Fire? 

If Regenerating: 
Crown-and-Ground 

Fire
or

Ground-Only Fire ?

Fraction of 
Stem, Branch 

and Bark 
Carbon Mass

That Becomes
Gas

Fraction of 
Stem, Branch 

and Bark 
Carbon Mass

That Becomes
Debris

Fraction of 
Pre-Fire Stem, 

Branch and 
Bark Carbon 

Mass
That is

Thinned

Fraction of 
De. Fine 

Decay 
Carbon Mass
Burnt in Fire

Fraction of 
Re. Fine 

Decay 
Carbon 

Mass
Burnt in 

Fire

Fraction of 
De. Coarse 

Decay 
Carbon 

Mass
Burnt in 

Fire

Fraction 
of Re. 

Coarse 
Decay 

Carbon 
Mass

Burnt in 
Fire

Fraction 
of De. 

Leaf Litter 
Carbon 

Mass
Burnt in 

Fire

Fraction 
of Re. 

Leaf Litter 
Carbon 

Mass
Burnt in 

Fire

Fraction 
of De. 

Bark Litter 
Carbon 

Mass
Burnt in 

Fire

Fraction 
of Re. 

Bark Litter  
Carbon 

Mass
Burnt in 

Fire

Fraction 
of De. 

Deadwood 
Carbon 

Mass
Burnt in 

Fire

Fraction 
of Re. 

Deadwood 
Carbon 

Mass
Burnt in 

Fire
y - - - - - - - - - - - - - - -

FireTime
Yr

Fire
StdRTbl

Fire
CrwnTbl

Fire
GasFrac

Fire
DebrFrac

Fire
ThinFrac

FireFrac
DeFDcy

FireFrac
ReFDcy

FireFrac
DeCDcy

FireFrac
ReCDcy

FireFrac
DeLLit

FireFrac
DeLLit

FireFrac
DeBLit

FireFrac
ReBLit

FireFrac
DeDwd

FireFrac
ReDwd

8 Stand Replacing Ground Only 0.25 0.33 0.42 0.12 0.12 0.12 0.12 0.95 0.90 0.85 0.80 0.75 0.60
1 7 Regenerating Crown and Ground 0.09 0.10 0.00 0.11 0.11 0.11 0.11 0.95 0.90 0.85 0.80 0.75 0.60
2 0 Regenerating Ground Only 0.00 0.00 0.00 0.03 0.03 0.03 0.03 0.95 0.90 0.85 0.80 0.75 0.60

1 2 2 Regenerating Ground Only 0.01 0.00 0.00 0.05 0.05 0.05 0.05 0.95 0.90 0.85 0.80 0.75 0.60
1 2 5 Regenerating Crown and Ground 0.05 0.05 0.00 0.10 0.10 0.10 0.10 0.95 0.90 0.85 0.80 0.75 0.60
1 2 8 Stand Replacing 0.20 0.20 0.60 0.15 0.15 0.15 0.15 0.95 0.90 0.85 0.80 0.75 0.60
1 2 0 Regenerating Ground Only 0.01 0.02 0.00 0.03 0.03 0.03 0.03 0.95 0.90 0.85 0.80 0.75 0.60
1 4 5 Regenerating Crown and Ground 0.04 0.04 0.00 0.09 0.09 0.09 0.09 0.95 0.90 0.85 0.80 0.75 0.60
1 7 5 Regenerating Crown and Ground 0.06 0.08 0.00 0.08 0.08 0.08 0.08 0.95 0.90 0.85 0.80 0.75 0.60
1 7 9 Stand Replacing 0.30 0.12 0.58 0.20 0.20 0.20 0.20 0.95 0.90 0.85 0.80 0.75 0.60
2 0 1 Regenerating Ground Only 0.01 0.02 0.00 0.03 0.03 0.03 0.03 0.95 0.90 0.85 0.80 0.75 0.60
2 2 7 Regenerating Crown and Ground 0.04 0.04 0.00 0.09 0.09 0.09 0.09 0.95 0.90 0.85 0.80 0.75 0.60
2 7 5 Regenerating Crown and Ground 0.06 0.08 0.00 0.08 0.08 0.08 0.08 0.95 0.90 0.85 0.80 0.75 0.60
2 7 6 Stand Replacing 0.30 0.12 0.58 0.20 0.20 0.20 0.20 0.95 0.90 0.85 0.80 0.75 0.60
2 8 8 Regenerating Crown and Ground 0.05 0.05 0.00 0.07 0.07 0.07 0.07 0.95 0.90 0.85 0.80 0.75 0.60
2 8 9 Regenerating Ground Only 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.95 0.90 0.85 0.80 0.75 0.60
3 3 8 Regenerating Crown and Ground 0.06 0.02 0.00 0.05 0.05 0.05 0.05 0.95 0.90 0.85 0.80 0.75 0.60
3 4 9 Stand Replacing 0.19 0.23 0.58 0.14 0.14 0.14 0.14 0.95 0.90 0.85 0.80 0.75 0.60
3 9 0 Regenerating Crown and Ground 0.05 0.05 0.00 0.05 0.05 0.05 0.05 0.95 0.90 0.85 0.80 0.75 0.60

Input 3/5: Fire



This is the sheet where you enter information about the species of tree in the stand (excluding growth data,
which goes on the next sheet). Only enter data in the light blue cells.

There are two tables you should enter data into (scroll down to find them):

1. ‘Species Description’ – Optional. Does not effect calculations. 

2. ‘Species Parameters’ – General information about the species.

For many users, there will be more parameters than you want. If that is the case, just make many of the
parameters the same (for example, if you make no distinction between fine roots and coarse roots, make each
fine root parameter equal to the corresponding coarse root parameter). However for users who need to make
finer distinctions, the machinery is there (for example, you might want to take into account that coarse roots
have a different lignin content than fine roots). 

3.6.1 Species Description 
Box for entering a description of the species of stands in this worksheet. Data entered here will not appear in
any calculations. 
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Enter any number of fires, one per row, in any order. You can delete or copy any rows after the first row:

- For more rows: Select the last row and the blank rows below it that you want to contain new rows,
then choose ‘Fill:Down’ from the ‘Edit’ menu.

- To delete rows: Select any rows, except the first, then choose ‘Delete’ from the ‘Edit’ menu.

If there are no fires, set the ‘Fire Time’ beyond the years simulated (so the simulation never gets to those
years), or delete the rows (but do not delete the first two rows, as you might not be able to recreate them if
you need them later).

Sort the rows by selecting them (including the first row) and choosing ‘Sort...’ from the ‘Data’ menu, then by
sorting by ‘FireTimeYr’. This table calculates the effects of fires on the stand. 

3.6 IN-SPECIES SHEET

Species Description
Name Example Species

Notes This species data is purely for illustrating how 
CAMFor works. Any resemblance to any species of 
tree is purely accidental. 

Input 4/5: Species
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Species Parameters
Name Description Value Units
Densities
BasicDensKg Density of stem wood 440 kg / m3
Self Thinning (only relevant if the stand is ’Natural’)
TreeMortFrac Fraction of trees that die each year naturally 0.02 1 / yr
Encapsulation Fractions (fractions lost due to encapsulation by clay each year)
EncpFracActv Encapsulation fraction of the active pool in the soil 0.005 1 / y
Carbon Fractions (fractions that are carbon, by weight) 
CFracStem Carbon fraction of stem 0.45 -
CFracBran Carbon fraction of branches 0.55 -
CFracBark Carbon fraction of bark 0.50 -
CFracLeaf Carbon fraction of leaves and twigs 0.60 -
CFracCRoot Carbon fraction of coarse roots 0.40 -
CFracFRoot Carbon fraction of fine roots 0.60 -
Turnover Fractions (average fractions lost due to turnover each year)
BranTurnFrac Turnover fraction of branches 0.03 1 / y
BarkTurnFrac Turnover fraction of bark 0.10 1 / y
LeafTurnFrac Turnover fraction of leaves and twigs 0.50 1 / y
CRootTurnFrac Turnover fraction of coarse roots 0.05 1 / y
FRootTurnFrac Turnover fraction of fine roots 0.09 1 / y
Decomposable Fractions (fractions not resistant to decomposition)
DeFracStem Decomposable fraction of stems 0.10 -
DeFracBran Decomposable fraction of branches 0.15 -
DeFracBark Decomposable fraction of bark 0.35 -
DeFracLeaf Decomposable fraction of leaves and twigs 0.65 -
DeFracCRoot Decomposable fraction of coarse roots 0.80 -
DeFracFRoot Decomposable fraction of fine roots 0.55 -
Breakdown Fractions (fractions of debris that breakdown each year)
BkdnFracDeFDcy Breakdown fraction of decomposable fine decay 0.80 1 / y
BkdnFracReFDcy Breakdown fraction of resistant fine decay 0.70 1 / y
BkdnFracDeCDcy Breakdown fraction of decomposable coarse decay 0.75 1 / y
BkdnFracReCDcy Breakdown fraction of resistant coarse decay 0.65 1 / y
BkdnFracDeLLit Breakdown fraction of decomposable leaf litter 0.95 1 / y
BkdnFracReLLit Breakdown fraction of resistant leaf litter 0.92 1 / y
BkdnFracDeBLit Breakdown fraction of decomposable bark litter 0.60 1 / y
BkdnFracReBLit Breakdown fraction of resistant bark litter 0.52 1 / y
BkdnFracDeDwd Breakdown fraction of decomposable deadwood 0.15 1 / y
BkdnFracReDwd Breakdown fraction of resistant deadwood 0.12 1 / y
Breakdown Ratios (ratios of carbon masses of gas to solid in breakdown products)
RatioGasDeFDcyBkdn Breakdown ratio of decomposable fine decay 4.5 -
RatioGasReFDcyBkdn Breakdown ratio of resistant fine decay 5.5 -
RatioGasDeCDcyBkdn Breakdown ratio of decomposable coarse decay 4.6 -
RatioGasReCDcyBkdn Breakdown ratio of resistant coarse decay 5.6 -
RatioGasDeLLitBkdn Breakdown ratio of decomposable leaf litter 4.7 -
RatioGasReLLitBkdn Breakdown ratio of resistant leaf litter 5.7 -
RatioGasDeBLitBkdn Breakdown ratio of decomposable bark litter 4.8 -
RatioGasReBLitBkdn Breakdown ratio of resistant bark litter 5.8 -
RatioGasDeDwdBkdn Breakdown ratio of decomposable deadwood 4.9 -
RatioGasReDwdBkdn Breakdown ratio of resistant deadwood 5.9 -
Burning Ratios (ratios of carbon masses of gas to solid in burning products)

3.6.2 Species Parameters
Table for entering data relating to the species of trees within the stand.
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3.7 IN-GROWTH SHEET

This sheet is where you enter the data about the growth rate of the species of tree in the stand. Only enter
data in the light blue cells (which cells are light blue depends on the choice in the ‘Growth Type’ table).

3.7.1 Growth Driver
Choose the type of data you are using in the growth table to specify how these trees grow. 

1. Yearly increases in stem volume.

2. Yearly increases in aboveground mass (mass of stem, branches, bark and leaves, post turnover).

Enter 1 or 2 in the growth driver table.

3.7.2 Growth Table
Fill in ALL the light blue cells in the ‘Growth’ table, for at least as many years are possible in a rotation (for a
managed stand), or for as many years as the length of the simulation (for a natural stand). You can add or
delete any rows after the second row (never delete or alter the first two rows):

- For more rows: Select the last row and the blank rows below it that you want to contain new rows,
then choose ‘Fill:Down’ from the ‘Edit’ menu.

- To delete rows: Select any rows, except the first two, then choose ‘Delete’ from the ‘Edit’ menu.

The age of rotation is the number of years since the trees in the current rotation were planted, and is thus the
maximum age of any tree in the stand. 

To enter new data, clear all the cells in a column (select the cells and choose ‘Clear: Contents’ from the ‘Edit’
menu) then enter the values you know (presumably only at some ages) then fill in the remaining cells by
linear interpolation: Select two known data points in a column and all the blank cells in between then choose
‘Fill:Series:Trend (linear)’ from the ‘Edit’ menu. 

With a little care, the ‘Growth’ table allows you to model uneven age stands (coordinate it with the
‘Thinning’ table) and mixed species stands (use weighted averages). 

Growth
Type

GrthType
1

Choose the type of data you are using in the ’Growth Inputs’ table:
  1 = Yearly increases in stem volume, year-on-year measurements
  2 = Yearly increases in aboveground mass (mass of stem, 
        branches, bark, leaves and twigs; equal to growth less 
        turnover), year-on-year measurements
<--- Enter ’1’ or ’2’

Input 5/5: Growth
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The stem mass is assumed to be always proportional to the stem volume: 

StemM = BasicDens * StemVol.

In the ‘Growth’ table, the ‘Yearly Increase in Aboveground Mass’ and the ‘Increase in Mass Relative to
Increase in Mass of Stem’ BOTH include both production and turnover. Further, they are both for a site
where all the ‘relative growth adjustments for non-standard sites’ (see the ‘In-General’ sheet) are equal to 1.
Thus these growth figures are NOT for growth (production) alone, but are year-on-year standing
measurements that include the effect of mass loss due to turnover. The ‘Yearly Increase in Aboveground
Mass’ is what you would measure if you simply measured the aboveground mass at the same time of year,
each year. We stress this point because some other models use growth-only relative factors (which do not
take turnover into account). Forestry measurements typically include growth and turnover, and thus are the
figures you enter into the ‘Growth’ table. 

Growth Inputs
Increase in Mass Relative to
Increase in Mass of Stem*

Age of 
Rotation

Yearly 
Increase in 

Stem 
Volume

Yearly Increase 
in 

Aboveground 
Mass*

Bran-
ches Bark

Leaves & 
Twigs

Coarse 
Roots

Fine 
Roots

yr m3 / ha t / ha - - - - -
StemVol

IncTbl
AbgM
IncTbl

BranM
IncTbl

BarkM
IncTbl

LeafM
IncTbl

CRootM
IncTbl

FRootM
IncTbl

1 0.50 0.13 0.98 0.98 1.90 1.45 1.90
2 1.00 1.45 0.96 0.96 1.80 1.40 1.80
3 1.50 2.33 0.94 0.94 1.70 1.35 1.70
4 2.00 2.97 0.92 0.92 1.60 1.30 1.60
5 2.50 3.47 0.90 0.90 1.50 1.25 1.50
6 3.00 3.89 0.88 0.88 1.40 1.20 1.40
7 3.50 4.24 0.86 0.86 1.30 1.15 1.30
8 4.00 4.56 0.84 0.84 1.20 1.10 1.20
9 4.50 4.84 0.82 0.82 1.10 1.05 1.10

1 0 5.00 5.09 0.80 0.80 1.00 1.00 1.00
1 1 5.50 5.50 0.77 0.77 0.98 0.95 0.98
1 2 6.00 5.81 0.74 0.74 0.96 0.90 0.96
1 3 6.50 6.05 0.71 0.71 0.94 0.85 0.94
1 4 7.00 6.25 0.68 0.68 0.92 0.80 0.92
1 5 7.50 6.41 0.65 0.65 0.90 0.75 0.90
1 6 8.36 7.09 0.62 0.62 0.88 0.70 0.88
1 7 9.22 7.62 0.59 0.59 0.86 0.65 0.86
1 8 10.08 8.05 0.56 0.56 0.84 0.60 0.84
1 9 10.94 8.41 0.53 0.53 0.82 0.55 0.82
2 0 11.80 8.72 0.50 0.50 0.80 0.50 0.80
2 1 12.28 8.77 0.49 0.49 0.79 0.50 0.79
2 2 12.76 8.87 0.48 0.48 0.78 0.50 0.78
2 3 13.24 9.00 0.47 0.47 0.77 0.50 0.77
2 4 13.72 9.14 0.46 0.46 0.76 0.50 0.76
2 5 14.20 9.28 0.45 0.45 0.75 0.50 0.75
2 6 14.30 8.95 0.44 0.44 0.74 0.50 0.74
2 7 14.40 8.71 0.43 0.43 0.73 0.50 0.73
2 8 14.50 8.52 0.42 0.42 0.72 0.50 0.72
2 9 14.60 8.37 0.41 0.41 0.71 0.50 0.71
3 0 14.70 8.23 0.40 0.40 0.70 0.50 0.70
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3.8 CALC PRELIM SHEET 

Assorted
Name Description Value Units
Assorted
BasicDens Density of stem wood (using tonnes) 0.440 t / m3

StdPrdCMInit Initial carbon mass of stand and products 121.49 t / ha

Managed Stand managed by people? TRUE -

Resistant Fractions (fractions of material that are resistant to decomposition)
ReFracStem Resistant fraction of stems 0.90 -
ReFracBran Resistant fraction of branches 0.85 -
ReFracBark Resistant fraction of bark 0.65 -
ReFracLeaf Resistant fraction of leaves and twigs 0.35 -
ReFracFRoot Resistant fraction of coarse roots 0.45 -
ReFracCRoot Resistant fraction of fine roots 0.20 -
Gas Fractions of Breakdown Carbon in Debris (fractions emitted as gas)
FracGasDeFDcyBkdn Decomposable fine decay 0.818 -
FracGasReFDcyBkdn Resistant fine decay 0.846 -
FracGasDeCDcyBkdn Decomposable coarse decay 0.821 -
FracGasReCDcyBkdn Resistant coarse decay 0.848 -
FracGasDeLLitBkdn Decomposable leaf litter 0.825 -
FracGasReLLitBkdn Resistant leaf litter 0.851 -
FracGasDeBLitBkdn Decomposable bark litter 0.828 -
FracGasReBLitBkdn Resistant bark litter 0.853 -
FracGasDeDwdBkdn Decomposable deadwood 0.831 -
FracGasReDwdBkdn Resistant deadwood 0.855 -
Solid Fractions of Breakdown Carbon in Debris (fractions not emitted as gas)
FracSolidDeFDcyBkdn Decomposable fine decay 0.182 -
FracSolidReFDcyBkdn Resistant fine decay 0.154 -
FracSolidDeCDcyBkdn Decomposable coarse decay 0.179 -
FracSolidReCDcyBkdn Resistant coarse decay 0.152 -
FracSolidDeLLitBkdn Decomposable leaf litter 0.175 -
FracSolidReLLitBkdn Resistant leaf litter 0.149 -
FracSolidDeBLitBkdn Decomposable bark litter 0.172 -
FracSolidReBLitBkdn Resistant bark litter 0.147 -
FracSolidDeDwdBkdn Decomposable deadwood 0.169 -
FracSolidReDwdBkdn Resistant deadwood 0.145 -
Gas Fractions of Burning Carbon in Debris (fractions emitted as gas)
FracGasDeFDcyBurn Decomposable fine decay 0.750 -
FracGasReFDcyBurn Resistant fine decay 0.756 -
FracGasDeCDcyBurn Decomposable coarse decay 0.762 -
FracGasReCDcyBurn Resistant coarse decay 0.767 -
FracGasDeLLitBurn Decomposable leaf litter 0.952 -
FracGasReLLitBurn Resistant leaf litter 0.955 -
FracGasDeBLitBurn Decomposable bark litter 0.957 -
FracGasReBLitBurn Resistant bark litter 0.958 -
FracGasDeDwdBurn Decomposable deadwood 0.833 -
FracGasReDwdBurn Resistant deadwood 0.875 -
Solid Fractions of Burning Carbon in Debris (fractions not emitted as gas)
FracSolidDeFDcyBurn Decomposable fine decay 0.250 -
FracSolidReFDcyBurn Resistant fine decay 0.244 -
FracSolidDeCDcyBurn Decomposable coarse decay 0.238 -
FracSolidReCDcyBurn Resistant coarse decay 0.233 -
FracSolidDeLLitBurn Decomposable leaf litter 0.048 -
FracSolidReLLitBurn Resistant leaf litter 0.045 -
FracSolidDeBLitBurn Decomposable bark litter 0.043 -
F S lidR BLitB

Calculations: Preliminary

This sheet computes some quantities that are needed by the main simulation calculations. The values in this
table are calculated from the data entered into the ‘Input tables’.



National Carbon Accounting System Technical Report 19

3.9 CALC SIM SHEET 

This sheet simulates the stand, year by year from year 0. Each year starts on the anniversary of the planting
of the stand. Each normal row (white) computes the state of the stand for one year; each thinning row
(purple) computes the effect of a thinning; each fire row (pinky-red) computes the effect of a fire. Each row
shows the state of the stand at the end of the year in the ‘Year’ column; thus thinings and fires occur at the
end of the year. Each row of the table is a separate calculation, depending only on the previous row. The first
row (light yellow) is the initialization row. All rows from the second onwards have identical formulae.

You can delete or copy any rows after the second row (never delete or alter the first two rows), to change the
length of the simulated period:

- For more rows: Select the last row and the blank rows below it that you want to contain new
calculation rows, then choose ‘Fill:Down’ from the ‘Edit’ menu.

- To delete rows : Select any rows, except the first two, and choose ‘Delete’ from the ‘Edit’ menu.
[Some computations/instructions may take some time to process, as the files increase in size.]

Timing, Thinning, and Fire Tree

Year 
of 

Simu-
lation 

Age of  
Current 

Rotation 

Average 
Age of 

Trees in 
Stand  

Stand 
Clear-

ed 
Last 

Year? 

Last 
Row’s 
State  

Age of  
Current 

Rotation, 
Ignoring 

Effect of 
Row 

Final 
Thin 

Due This 
Year 

?

Thin 
This 

Year?

Fire 
This 

Year? State 
Normal 

Row?

Thin-
ning 

Row?
Fire 

Row?

Row 
Index 

into 
the 
Fire 

Table

Stand 
Replac-

ing 
Fire?

Fire in 
Crown

?

Row 
Index 

into 
the 

Thin-
ning 

Table

Row 
Index 

into 
the 

Growt
h 

Table

Frac-
tion of 
Trees 

that 
are 

Thin-
ned 

Stand 
Clear-

ed This 
Year

?

Un
St

Incr
to

y y - - - y - - - - - - - - - - - - -

Yr RotAge
Stand

AgeAvg
Clear
Last

State
Last RotAgeYr

FinalThin
Due

Thin
Year

Fire
Year State

Norm
Row

Thin
Row

Fire
Row

Fire
Index

Fire
StdR

Fire
Crwn

Thin
Index

Grth
Index

Thin
Frac Clear

0 3 3.0 3 -1 FALSE
1 4 4.0 FALSE -1 4 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 4 0.00 FALSE
2 5 5.0 FALSE -1 5 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 5 0.00 FALSE
3 6 6.0 FALSE -1 6 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 6 0.00 FALSE
4 7 7.0 FALSE -1 7 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 7 0.00 FALSE
5 8 8.0 FALSE -1 8 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 8 0.00 FALSE
6 9 9.0 FALSE -1 9 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 9 0.00 FALSE
7 1 0 10.0 FALSE -1 1 0 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 1 0 0.00 FALSE
8 1 1 11.0 FALSE -1 1 1 FALSE FALSE TRUE 2 TRUE FALSE FALSE FALSE FALSE 1 1 0.00 FALSE
8 0 0.0 FALSE 2 1 1 FALSE -3 FALSE FALSE TRUE 1 TRUE TRUE 1 1 0.42 TRUE
9 1 1.0 TRUE -3 1 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 1 0.00 FALSE

1 0 2 2.0 FALSE -1 2 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 2 0.00 FALSE
1 1 3 3.0 FALSE -1 3 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 3 0.00 FALSE
1 2 4 4.0 FALSE -1 4 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 4 0.00 FALSE
1 3 5 5.0 FALSE -1 5 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 5 0.00 FALSE
1 4 6 6.0 FALSE -1 6 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 6 0.00 FALSE
1 5 7 7.0 FALSE -1 7 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 7 0.00 FALSE
1 6 8 8.0 FALSE -1 8 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 8 0.00 FALSE
1 7 9 9.0 FALSE -1 9 FALSE FALSE TRUE 2 TRUE FALSE FALSE FALSE FALSE 9 0.00 FALSE
1 7 9 9.0 FALSE 2 9 FALSE -3 FALSE FALSE TRUE 2 FALSE TRUE 9 0.00 FALSE
1 8 1 0 10.0 FALSE -3 1 0 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 1 0 0.00 FALSE
1 9 1 1 11.0 FALSE -1 1 1 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 1 1 0.00 FALSE
2 0 1 2 12.0 FALSE -1 1 2 FALSE FALSE TRUE 2 TRUE FALSE FALSE FALSE FALSE 1 2 0.00 FALSE
2 0 1 2 12.0 FALSE 2 1 2 FALSE -3 FALSE FALSE TRUE 3 FALSE FALSE 1 2 0.00 FALSE
2 1 1 3 13.0 FALSE -3 1 3 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 1 3 0.00 FALSE
2 2 1 4 14.0 FALSE -1 1 4 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 1 4 0.00 FALSE
2 3 1 5 15.0 FALSE -1 1 5 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 1 5 0.00 FALSE
2 4 1 6 16.0 FALSE -1 1 6 FALSE TRUE FALSE 3 TRUE FALSE FALSE FALSE FALSE 1 6 0.00 FALSE
2 4 1 6 13.3 FALSE 3 1 6 FALSE -2 FALSE TRUE FALSE FALSE FALSE 2 1 3 0.17 FALSE
2 5 1 7 14.3 FALSE -2 1 7 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 1 4 0.00 FALSE
2 6 1 8 15.3 FALSE -1 1 8 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 1 5 0.00 FALSE
2 7 1 9 16.3 FALSE -1 1 9 FALSE FALSE FALSE -1 TRUE FALSE FALSE FALSE FALSE 1 6 0.00 FALSE
2 8 2 0 17 3 FALSE 1 2 0 FALSE TRUE FALSE 3 TRUE FALSE FALSE FALSE FALSE 1 7 0 00 FALSE

Calculations: Simulation
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3.10 OUT-SIM SHEET

This sheet reports the highlights of the simulation by copying results from the ‘Calc-Sim’ sheet. It is intended
to be printed on a black and white printer (and of course it can be viewed on the screen). You can delete or
add more rows after the first and second rows (but never delete or alter the first two rows):

- For more rows: Select the last row and the blank rows below it that you want to contain new rows,
then choose ‘Fill’ then ‘Down’ from the ‘Edit’ menu.

- To delete rows: Select any rows, except the first and second, and then choose ‘Delete’ from the
‘Edit’ menu.

For more detailed results, see the ‘Calc-Sim’ sheet directly.

Stand State Summary: Yearly
Site: Example Stand

Species: Example Species

Year
Rotation 

Age

Tree 
Carbon 

Mass

Debris 
Carbon 

Mass

Soil 
Carbon 

Mass

Product 
Carbon 

Mass
Total Carbon 

Mass

Fraction of 
Total Carbon 

Mass In 
Products

Calc-Sim 
Table Row 

Index

y t / ha t / ha t / ha t / ha t / ha t / ha -

0 3.0 9.49 57.00 55.00 0.00 121.49 0.0% 1
1 4.0 13.00 30.31 59.44 0.00 102.76 0.0% 2
2 5.0 17.20 22.36 60.91 0.00 100.47 0.0% 3
3 6.0 22.03 18.91 61.76 0.00 102.70 0.0% 4
4 7.0 27.40 17.23 62.47 0.00 107.10 0.0% 5
5 8.0 33.23 16.43 63.19 0.00 112.86 0.0% 6
6 9.0 39.47 16.14 63.99 0.00 119.60 0.0% 7
7 10.0 46.03 16.18 64.90 0.00 127.11 0.0% 8

Output: Simulation Results

Output: Graphs

This sheet graphs some simulation outputs from the ‘Calc-Sim’ sheet. You can change a lot about the
appearance of the graphs relatively easily. For example, double-click on the axis labels or graph lines to edit
them. You can also resize, move, copy and paste graphs.

1. You may want to change the scales on the graphs. Double-clicking on the numbers of an axis will
open the ‘Format Axis’ dialog box, then choose the ‘Scale’ tab. 

2. You may want to change the data sources. Select the graph by clicking on it, choose ‘Source Data’
from the ‘Chart’ menu, the choose the ‘Series’ tab. This shows where the data is coming from. [It’s an
unwieldly interface that only accepts cell references.]



3. To print, choose a graph by clicking on it once then choose ‘Print’ from the ‘File’ menu. 
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3.12 GROUP SHEET

Carbon Mass Per Hectare In This Type of Stand
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Stand Aggregation: Specify a Group of Stands

This sheet is where you enter information about a group of stands. A ‘group’ of stands is a number of stands
with the same management regime and species (and are thus in the same CAMFor workbook). Each stand in
the group is as described in the input (‘In-’) sheets. For each stand, enter:

1. The year it was started (notice that the simulation just used years 0,1,2,... of the stand’s life).

2. Its area (notice that the simulation calculated masses in tonnes per hectare).

3. A description (optional, no effect on calculations). 

The carbon masses of the group of stands specified in this sheet are calculated on the ‘Group CM’ sheet.

Only fill in the light blue cells. Enter as many stands as you like. If you do not want a stand in a given row of
the table, leave that row blank (no start-year or area). You can delete or copy any rows after the first row
(never delete or alter the first row):

- For more rows: Select the last row and the blank rows below it that you want to contain new data
rows, then choose ‘Fill’ then ‘Down’ from the ‘Edit’ menu.

- To delete rows: Select any rows, except the first, and then choose ‘Delete’ from the ‘Edit’ menu.
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3.13 GROUP CM TOTALS SHEET 

Stands
Starting
Year of 

Stand
Area of 

Stand Stand Description
- ha

Group

StartYr

Group

Area

1980 100

1984 310

1986 130

1987 430

1988 230

1990 130

1990 270

Stand Aggregation: Carbon Mass Totals for the Group of Stands

This sheet is where the carbon mass totals of the group of stands specified on the ‘Group’ sheet are
calculated. A ‘group’ of stands is a number of stands with the same management regime and species (and are
thus in the same CAMFor workbook). Note the graph over the page.

This sheet is mainly an output sheet; do not enter anything on this sheet - except in the light blue cells (name
and notes in the ‘Group Description’ table, and the years in the ‘Group Carbon Masses in Years of Special
Interest’ table). The name and notes are optional and have no effect on calculations.

A ‘carbon mass (total)’ is the carbon mass on the site once the stand has started to grow, but is zero before the
stand starts. That is, the ‘carbon mass total’ is the total carbon due to the stand itself and ignores the carbon
on a stand site before the stand is started.

A ‘carbon mass increment’ is the carbon mass on the site less the carbon on the site that was there before the
stand was started. That is, the ‘carbon mass increment’ is the change in non-atmospheric carbon due to
planting the stand. The ‘carbon on the site that was there before the stand was started’ is defined by the
initial conditions of the site when the stand was started. 

For example, suppose you have a group with two stands, one planted in 1960 and one planted in 1965. 

In 1962:

- The carbon mass total of the group is the carbon on the site in 1962 of the stand planted in 1960
(there is no contribution to the total from the stand yet to be planted).

- The carbon mass increment of the group is the carbon on the site of the 1960 stand in 1962, less the
carbon on the site of the 1960 stand in 1960, plus the carbon on the site of the 1965 stand in 1962
(assumed to be as in 1965) less the carbon on the site of the 1965 stand in 1965.
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In 1968:

- The carbon mass total of the group is the carbon on the site of the 1960 stand in 1968, plus the carbon
on the site of the 1965 stand in 1968.

- The carbon mass increment of the group is the carbon on the site of the 1960 stand in 1968, less the
carbon on the site of the 1960 stand in 1960, plus the carbon on the site of the 1965 stand in 1968, less
the carbon on the site of the 1965 stand in 1965.

Stand Aggregation: Carbon Mass Totals for the Group of Stands

Group Description
Name Group Example

Notes Example of a group of stands.

Group Statistics
Number of Stands 7

Number of Groups 1

Total Area (ha) 1,600

Start Year 1980

End Year 2257

Results Period (y) 277

Group Carbon Masses Group Carbon Masses in Years of Special Interest Group Computations of Carbon Masses

Year 
Carbon Mass in 

Trees
Carbon Mass in 

Debris
Carbon Mass in 

Soil
Carbon Mass in 

Products

Total Carbon Mass 
in Stand and 

Products Year 
Row 

Index
Carbon Mass in 

Trees
Carbon Mass in 

Debris
Carbon Mass in 

Soil
Carbon Mass in 

Products

Total Carbon 
Mass in Stand 
and Products

Number 
of Sum-
Product 

Rows
Area 

Planted

Rev-
erse 
Year 

Row 
Index To 

Calcs

Carbon 
Mass in 

Trees

Carbon 
Mass in 
Debris

Carbon 
Mass in 

Soil

Carbon 
Mass in 

Products
yr t t t t t yr t t t t t - ha yr t / ha t / ha t / ha t / ha

Est

Year

Est

TreeCM

Est

DebrCM

Est

SoilCM

Est

PrdCM

GNum

Rows GArea GTreeCM GDebrCM GSoilCM GPrdCM

1980 949 5,700 5,500 0 1 2 , 1 4 9 1980 1 949 5,700 5,500 0 1 2 , 1 4 9 1 100 277 326 0.99 4.19 328.61 56.45

1981 1,300 3,031 5,944 0 1 0 , 2 7 6 1995 1 6 28,111 27,767 106,774 5,988 1 6 8 , 6 4 1 2 0 276 325 0.00 11.08 329.06 59.45

1982 1,720 2,236 6,091 0 1 0 , 0 4 7 2000 2 1 24,907 11,441 112,304 6,553 1 5 5 , 2 0 5 3 0 275 323 12.03 3.37 330.35 57.89

1983 2,203 1,891 6,176 0 1 0 , 2 7 0 2008 2 9 80,395 14,951 115,967 6,724 2 1 8 , 0 3 8 4 0 274 321 13.36 8.60 331.05 60.67

1984 5,680 19,393 23,297 0 4 8 , 3 7 1 2009 3 0 93,058 14,138 117,204 5,657 2 3 0 , 0 5 7 5 310 273 320 9.15 9.09 332.40 64.01

1985 7,353 11,040 24,747 0 4 3 , 1 4 0 2010 3 1 104,628 15,766 118,418 5,897 2 4 4 , 7 0 9 6 0 272 319 5.64 10.52 333.73 68.11

1986 10,513 15,956 32,431 0 5 8 , 9 0 0 2011 3 2 112,902 21,743 119,784 7,395 2 6 1 , 8 2 3 7 130 271 318 2.89 14.63 334.73 73.27

1987 17,200 35,932 57,015 0 1 1 0 , 1 4 7 2012 3 3 117,119 27,468 121,894 9,791 2 7 6 , 2 7 2 8 430 270 317 0.99 30.06 333.90 80.18

1988 18,500 37,365 72,196 790 1 2 8 , 8 5 1 2020 4 1 160,838 42,539 149,019 19,652 3 7 2 , 0 4 9 9 230 269 316 0.00 127.85 319.07 94.51

1989 23,652 25,490 74,429 606 1 2 4 , 1 7 7 2040 6 1 123,091 27,965 198,092 39,178 3 8 8 , 3 2 6 1 0 0 268 314 143.70 30.26 316.95 36.68

1990 33,309 44,191 97,526 527 1 7 5 , 5 5 3 1 1 400 267 313 133.17 28.74 315.06 38.00

1991 41,198 31,749 100,185 470 1 7 3 , 6 0 2 1 2 0 266 312 123.24 27.87 313.32 39.55

1992 33,519 31,940 101,993 2,876 1 7 0 , 3 2 8 1 3 0 265 311 113.95 29.28 311.45 41.51

1993 41,052 25,229 103,725 2,273 1 7 2 , 2 8 0 1 4 0 264 310 105.37 45.86 307.21 46.42

1994 42,542 24,816 105,024 3,028 1 7 5 , 4 1 0 1 5 0 263 308 122.86 25.63 305.55 38.04

1995 28,111 27,767 106,774 5,988 1 6 8 , 6 4 1 1 6 0 262 307 112.92 24.17 304.10 39.32

1996 22,365 23,076 108,719 6,761 1 6 0 , 9 2 0 1 7 0 261 306 103.64 23.31 302.80 40.79

1997 27,079 16,670 109,966 5,805 1 5 9 , 5 1 9 1 8 0 260 305 95.05 24.42 301.40 42.62

1998 12,894 20,297 110,952 8,386 1 5 2 , 5 3 0 1 9 0 259 304 86.81 38.92 297.94 47.01

1999 18,345 13,467 111,974 7,214 1 5 1 , 0 0 1 2 0 0 258 302 101.36 21.04 296.76 39.96

2000 24,907 11,441 112,304 6,553 1 5 5 , 2 0 5 2 1 0 257 301 92.07 19.87 295.75 41.22

2001 28,623 10,002 112,650 6,051 1 5 7 , 3 2 6 2 2 0 256 300 83.49 19.99 294.77 42.70

2002 37,062 10,321 112,785 5,651 1 6 5 , 8 1 9 2 3 0 255 299 75.25 28.64 292.55 45.76

2003 44,726 10,663 113,116 5,327 1 7 3 , 8 3 2 2 4 0 254 297 81.37 16.69 291.87 41.77

2004 48,116 9,445 113,799 5,528 1 7 6 , 8 8 8 2 5 0 253 296 72.79 15.22 291.40 42.88

2005 55,845 9,233 114,242 5,109 1 8 4 , 4 3 0 2 6 0 252 295 64.55 13.86 291.15 44.05

2006 67,096 10,238 114,626 4,865 1 9 6 , 8 2 5 2 7 0 251 294 56.68 12.64 291.09 45.30

2007 74,073 8,942 115,461 4,661 2 0 3 , 1 3 7 2 8 0 250 293 49.21 11.56 291.23 46.64

2008 80,395 14,951 115,967 6,724 2 1 8 , 0 3 8 2 9 0 249 292 42.18 10.63 291.54 48.08

2009 93,058 14,138 117,204 5,657 2 3 0 , 0 5 7 3 0 0 248 291 35.62 9.80 292.02 49.67

2010 104,628 15,766 118,418 5,897 2 4 4 , 7 0 9 3 1 0 247 290 29.39 9.11 292.67 51.43

2011 112,902 21,743 119,784 7,395 2 6 1 , 8 2 3 3 2 0 246 289 23.55 8.59 293.48 53.42

2012 117,119 27,468 121,894 9,791 2 7 6 , 2 7 2 3 3 0 245 288 18.18 8.28 294.43 55.71

2013 128,321 25,285 124,666 8,853 2 8 7 , 1 2 5 3 4 0 244 287 13.36 8.26 295.51 58.40

2014 134,602 30,443 127,090 10,685 3 0 2 , 8 2 0 3 5 0 243 286 9.15 8.70 296.65 61.63

2015 139,631 33,906 130,130 12,278 3 1 5 , 9 4 5 3 6 0 242 285 5.64 10.07 297.78 65.59

2016 148,971 33,091 133,541 11,957 3 2 7 , 5 5 9 3 7 0 241 284 2.89 14.02 298.59 70.59

2017 155,633 36,688 136,778 13,190 3 4 2 , 2 9 0 3 8 0 240 283 0.99 28.07 297.76 77.29

2018 146,901 48,287 140,435 20,086 3 5 5 , 7 1 0 3 9 0 239 282 0.00 104.82 286.26 91.18

2019 157,530 37,490 145,509 17,773 3 5 8 , 3 0 2 4 0 0 238 280 127.25 21.97 285.20 34.97

2020 160,838 42,539 149,019 19,652 3 7 2 , 0 4 9 4 1 0 237 279 116.73 20.40 284.38 36.24

2021 169,353 40,933 153,154 18,849 3 8 2 , 2 8 8 4 2 0 236 278 106.79 19.45 283.73 37.71

2022 138,355 66,317 157,015 34,484 3 9 6 , 1 7 2 4 3 0 235 277 97.51 20.45 283.01 39.59

2023 140,537 46,107 164,138 32,858 3 8 3 , 6 4 0 4 4 0 234 276 88.92 31.37 280.82 44.29

2024 133,996 48,572 168,280 36,066 3 8 6 , 9 1 3 4 5 0 233 274 102.04 15.05 280.62 36.25

2025 82,584 75,223 172,733 56,753 3 8 7 , 2 9 2 4 6 0 232 273 92.10 13.51 280.66 37.47

2026 57,311 55,643 180,540 61,802 3 5 5 , 2 9 5 4 7 0 231 272 82.82 12.51 280.87 38.87

2027 64,851 28,465 185,387 54,244 3 3 2 , 9 4 7 4 8 0 230 271 74.24 13.00 281.07 40.61

2028 14,134 60,196 186,592 72,584 3 3 3 , 5 0 6 4 9 0 229 270 65.99 19.77 280.44 44.73

2029 19,585 22,617 192,052 63,688 2 9 7 , 9 4 2 5 0 0 228 268 74.67 6.94 281.30 38.18

2030 26,146 16,420 192,340 58,413 2 9 3 , 3 1 9 5 1 0 227 267 65.38 6.74 282.15 39.40

2031 33,704 15,090 192,017 54,337 2 9 5 , 1 4 7 5 2 0 226 265 83.49 19.95 280.31 40.84

2032 42,142 15,130 191,703 51,059 3 0 0 , 0 3 4 5 3 0 225 264 75.25 28.60 278.14 43.86

2033 51,417 15,769 191,547 48,362 3 0 7 , 0 9 5 5 4 0 224 262 81.37 16.64 277.51 39.83

2034 59,926 17,825 191,604 46,599 3 1 5 , 9 5 4 5 5 0 223 261 72.79 15.16 277.10 40.90

2035 70,505 18,093 192,035 44,450 3 2 5 , 0 8 3 5 6 0 222 260 64.55 13.80 276.90 42.03

2036 81,756 19,436 192,581 42,700 3 3 6 , 4 7 2 5 7 0 221 259 56.68 12.56 276.90 43.23

2037 93,690 21,120 193,380 41,158 3 4 9 , 3 4 8 5 8 0 220 258 49.21 11.47 277.09 44.52

2038 99,133 27,891 194,464 42,157 3 6 3 , 6 4 5 5 9 0 219 257 42.18 10.53 277.45 45.93

2039 111,796 25,184 196,462 39,928 3 7 3 , 3 6 9 6 0 0 218 256 35.62 9.69 278.00 47.48

2040 123,091 27,965 198,092 39,178 3 8 8 , 3 2 6 6 1 0 217 255 29.39 8.98 278.71 49.20

2041 130,459 33,252 200,118 39,845 4 0 3 , 6 7 5 6 2 0 216 254 23.55 8.44 279.58 51.16

2042 133,491 38,496 202,830 41,469 4 1 6 , 2 8 6 6 3 0 215 253 18.18 8.12 280.59 53.42

2043 144,525 34,722 206,166 39,611 4 2 5 , 0 2 5 6 4 0 214 252 13.36 8.08 281.73 56.09

2044 149,669 40,298 208,941 40,780 4 3 9 , 6 8 7 6 5 0 213 251 9.15 8.49 282.94 59.32

2045 153,725 43,036 212,424 41,661 4 5 0 , 8 4 5 6 6 0 212 250 5.64 9.84 284.13 63.30

2046 162,544 41,260 216,188 40,587 4 6 0 , 5 7 8 6 7 0 211 249 2.89 13.86 284.99 68.35

2047 168,684 44,447 219,652 41,121 4 7 3 , 9 0 4 6 8 0 210 248 0.99 29.18 284.02 75.13

2048 158,413 56,524 223,495 47,526 4 8 5 , 9 5 8 6 9 0 209 247 0.00 126.84 269.06 89.33

2049 168,823 43,962 228,845 44,466 4 8 6 , 0 9 5 7 0 0 208 245 143.70 29.11 266.80 31.38

2050 171,407 49,122 232,377 45,758 4 9 8 , 6 6 3 7 1 0 207 244 133.17 27.42 264.77 32.57

2051 179,534 46,866 236,568 44,311 5 0 7 , 2 7 8 7 2 0 206 243 123.24 26.35 262.90 33.97

2052 146,571 73,251 240,402 59,637 5 1 9 , 8 6 2 7 3 0 205 242 113.95 27.49 260.90 35.79

2053 148,080 51,225 247,666 57,416 5 0 4 , 3 8 6 7 4 0 204 241 105.37 43.72 256.55 40.56

2054 140,715 53,349 251,679 60,100 5 0 5 , 8 4 2 7 5 0 203 239 122.86 22.94 254.80 32.03

Carbon Mass Totals for the Group of Stands
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This sheet is where the carbon mass totals of the group of stands specified on the 'Group' sheet are calculated. A 'group' of

stands is a bunch of stands with the same management regime and species (and are thus in the same CAMFor workbook).

Note the graph below.

This sheet is mainly an output sheet; do not enter anything on this sheet -- except in the light blue cells (name and notes in

the 'Group Description' table, and the years in the 'Group Carbon Masses in Years of Special Interest' table). The name and

notes are optional and have no effect on calculations.

You can change a lot about the appearance of this graph fairly easily. For example, double-click on the axis labels or graph

lines to edit them. You can also resize, move, copy and paste graphs.

1. You may want to fiddle with the scales on the graphs. Double-clicking on the numbers of an axis will open the

'Format Axis' dialog box, then choose the 'Scale' tab.

2. You may want to fiddle with the data sources. Select the graph by clicking on it, choose 'Source Data' from

the 'Chart' menu, the choose the 'Series' tab. This shows where the data is coming from. It's an unwieldly

interface that only accepts cell references; good luck.

3. To print, choose a graph by clicking on it once then choose 'Print' from the 'File' menu.

A 'carbon mass (total)' is the carbon mass on the site once the stand has started, but is zero before the stand starts. That

is, the 'carbon mass total' is the total carbon due to the stand itself and ignores the carbon on a stand site before the stand

is started.

A 'carbon mass increment' is the carbon mass on the site less the carbon on the site that was there before the stand was

started. That is, the 'carbon mass increment' is the change in non-atmospheric carbon due to planting the stand. The

'carbon on the site that was there before the stand was started' is defined by the initial conditions of the site when the stand

was started (we assume that the pre-stand carbon on a site is constant, because we don't know any better).

For example, suppose you have a group with two stands, one planted in 1960 and one planted in 1965. In 1962:

- The carbon mass total of the group is the carbon on the site in 1962 of the stand planted in 1960 (there is no

contribution to the total from the stand yet to be planted).

- The carbon mass increment of the group is the carbon on the site of the 1960 stand in 1962, less the carbon

on the site of the 1960 stand in 1960, plus the carbon on the site of the 1965 stand in 1962 (assumed to be

as in 1965) less the carbon on the site of the 1965 stand in 1965.

In 1968:

- The carbon mass total of the group is the carbon on the site of the 1960 stand in 1968, plus the carbon on

the site of the 1965 stand in 1968.

- The carbon mass increment of the group is the carbon on the site of the 1960 stand in 1968, less the carbon

on the site of the 1960 stand in 1960, plus the carbon on the site of the 1965 stand in 1968, less the carbon

on the site of the 1965 stand in 1965.
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3.14 GROUP CM INCREMENTS SHEET 

Stand Aggregation: Carbon Mass Increments for the Group of Stands

This sheet is where the carbon mass increments of the group of stands specified on the ‘Group’ sheet are
calculated. A ‘group’ of stands is a bunch of stands with the same management regime and species (and are
thus in the same CAMFor workbook). Note the graph below.

This sheet is mainly an output sheet; do not enter anything on this sheet - except in the light blue cells (name
and notes in the ‘Group Description’ table, and the years in the ‘Group Carbon Masses in Years of Special
Interest’ table). The name and notes are optional and have no effect on calculations.

A ‘carbon mass (total)’ is the carbon mass on the site once the stand has started to grow, but is zero before the
stand starts. That is, the ‘carbon mass total’ is the total carbon due to the stand itself and ignores the carbon
on a stand site before the stand is started.

Stand Aggregation: Carbon Mass Increments for the Group of Stands
Group Computations - Pre-Stand Carbon Masses
Initial Carbon Masses
TreeCMInit Initial carbon mass of trees 9.49
DebrCMInit Initial carbon mass of debris 57.00
SoilCMInit Initial carbon mass of soil 55.00
PrdCMInit Initial carbon mass of products 0.00

Group Description
Name Group Example

Notes Example of a group of stands.

Group Statistics
Number of Stands 7
Number of Groups 1
Total Area (ha) 1,600
Start Year 1980
End Year 2257
Results Period (y) 277

Group Carbon Mass Increments Group Carbon Mass Increments in Years of Special Interest Group Computations of Carbon Mass Increments

Year 

Carbon Mass 
Increment in 

Trees

Carbon Mass 
Increment in 

Debris

Carbon Mass 
Increment in 

Soil

Carbon Mass 
Increment in 

Products

Total Carbon Mass 
Increment in Stand 

and Products Year 
Row 

Index

Carbon Mass 
Increment in 

Trees

Carbon Mass 
Increment in 

Debris

Carbon Mass 
Increment in 

Soil

Carbon Mass 
Increment in 

Products

Total Carbon Mass 
Increment in Stand 

and Products

Number 
of Sum-
Product 

Rows
Area 

Planted

Rev-
erse 
Year 

Row 
Index To 

Calcs

Carbon 
Mass in 

Trees

Carbon 
Mass in 
Debris

Carbon 
Mass in 

Soil
yr t t t t t yr t  t t t t - ha yr t / ha t / ha t / ha

Est
TreeCMInc

Est
DebrCMInc

Est
SoilCMInc

Est
PrdCMInc

1980 0 0 0 0 0 1980 1 0 0 0 0 0 1 100 277 326 -8.50 -52.81 273.61
1981 351 -2,669 444 0 -1,873 1995 1 6 12,933 -63,433 18,774 5,988 -25,737 2 0 276 325 -9.49 -45.92 274.06
1982 772 -3,464 591 0 -2,101 2000 2 1 9,729 -79,759 24,304 6,553 -39,173 3 0 275 323 2.54 -53.63 275.35
1983 1,254 -3,809 676 0 -1,878 2008 2 9 65,218 -76,249 27,967 6,724 2 3 , 6 6 0 4 0 274 321 3.87 -48.40 276.05
1984 1,791 -3,977 747 0 -1,439 2009 3 0 77,881 -77,062 29,204 5,657 3 5 , 6 7 9 5 310 273 320 -0.33 -47.91 277.40
1985 3,464 -12,330 2,197 0 -6,670 2010 3 1 89,450 -75,434 30,418 5,897 5 0 , 3 3 1 6 0 272 319 -3.85 -46.48 278.73
1986 5,391 -14,824 2,731 0 -6,702 2011 3 2 97,724 -69,457 31,784 7,395 6 7 , 4 4 6 7 130 271 318 -6.59 -42.37 279.73
1987 7,998 -19,358 3,665 0 -7,694 2012 3 3 101,942 -63,732 33,894 9,791 8 1 , 8 9 5 8 430 270 317 -8.50 -26.94 278.90
1988 7,117 -31,035 6,196 790 -16,932 2020 4 1 145,661 -48,661 61,019 19,652 1 7 7 , 6 7 1 9 230 269 316 -9.49 70.85 264.07
1989 12,269 -42,910 8,429 606 -21,606 2040 6 1 107,914 -63,235 110,092 39,178 1 9 3 , 9 4 8 1 0 0 268 314 134.21 -26.74 261.95
1990 18,131 -47,009 9,526 527 -18,825 1 1 400 267 313 123.69 -28.26 260.06
1991 26,020 -59,451 12,185 470 -20,775 1 2 0 266 312 113.75 -29.13 258.32
1992 18,341 -59,260 13,993 2,876 -24,049 1 3 0 265 311 104.47 -27.72 256.45
1993 25,874 -65,971 15,725 2,273 -22,098 1 4 0 264 310 95.88 -11.14 252.21
1994 27,364 -66,384 17,024 3,028 -18,968 1 5 0 263 308 113.37 -31.37 250.55
1995 12,933 -63,433 18,774 5,988 -25,737 1 6 0 262 307 103.44 -32.83 249.10
1996 7,187 -68,124 20,719 6,761 -33,457 1 7 0 261 306 94.15 -33.69 247.80
1997 11,901 -74,530 21,966 5,805 -34,859 1 8 0 260 305 85.57 -32.58 246.40
1998 -2,283 -70,903 22,952 8,386 -41,848 1 9 0 259 304 77.32 -18.08 242.94
1999 3,168 -77,733 23,974 7,214 -43,377 2 0 0 258 302 91.87 -35.96 241.76
2000 9,729 -79,759 24,304 6,553 -39,173 2 1 0 257 301 82.59 -37.13 240.75
2001 13,445 -81,198 24,650 6,051 -37,052 2 2 0 256 300 74.01 -37.01 239.77
2002 21,884 -80,879 24,785 5,651 -28,558 2 3 0 255 299 65.76 -28.36 237.55
2003 29,548 -80,537 25,116 5,327 -20,546 2 4 0 254 297 71.89 -40.31 236.87
2004 32,938 -81,755 25,799 5,528 -17,489 2 5 0 253 296 63.31 -41.78 236.40
2005 40,667 -81,967 26,242 5,109 -9,948 2 6 0 252 295 55.06 -43.14 236.15
2006 51,918 -80,962 26,626 4,865 2 , 4 4 7 2 7 0 251 294 47.19 -44.36 236.09
2007 58,895 -82,258 27,461 4,661 8 , 7 5 9 2 8 0 250 293 39.72 -45.44 236.23
2008 65,218 -76,249 27,967 6,724 2 3 , 6 6 0 2 9 0 249 292 32.69 -46.37 236.54
2009 77,881 -77,062 29,204 5,657 3 5 , 6 7 9 3 0 0 248 291 26.14 -47.20 237.02
2010 89,450 -75,434 30,418 5,897 5 0 , 3 3 1 3 1 0 247 290 19.90 -47.89 237.67
2011 97,724 -69,457 31,784 7,395 6 7 , 4 4 6 3 2 0 246 289 14.06 -48.41 238.48
2012 101,942 -63,732 33,894 9,791 8 1 , 8 9 5 3 3 0 245 288 8.69 -48.72 239.43
2013 113,144 -65,915 36,666 8,853 9 2 , 7 4 8 3 4 0 244 287 3.87 -48.74 240.51
2014 119,425 -60,757 39,090 10,685 1 0 8 , 4 4 2 3 5 0 243 286 -0.33 -48.30 241.65
2015 124,453 -57,294 42,130 12,278 1 2 1 , 5 6 8 3 6 0 242 285 -3.85 -46.93 242.78
2016 133,793 -58,109 45,541 11,957 1 3 3 , 1 8 2 3 7 0 241 284 -6.59 -42.98 243.59
2017 140,456 -54,512 48,778 13,190 1 4 7 , 9 1 2 3 8 0 240 283 -8.50 -28.93 242.76
2018 131,724 -42,913 52,435 20,086 1 6 1 , 3 3 2 3 9 0 239 282 -9.49 47.82 231.26
2019 142,352 -53,710 57,509 17,773 1 6 3 , 9 2 4 4 0 0 238 280 117.76 -35.03 230.20
2020 145,661 -48,661 61,019 19,652 1 7 7 , 6 7 1 4 1 0 237 279 107.24 -36.60 229.38
2021 154,175 -50,267 65,154 18,849 1 8 7 , 9 1 1 4 2 0 236 278 97.31 -37.55 228.73
2022 123,178 -24,883 69,015 34,484 2 0 1 , 7 9 4 4 3 0 235 277 88.02 -36.55 228.01
2023 125,360 -45,093 76,138 32,858 1 8 9 , 2 6 2 4 4 0 234 276 79.44 -25.63 225.82
2024 118,819 -42,628 80,280 36,066 1 9 2 , 5 3 5 4 5 0 233 274 92.55 -41.95 225.62
2025 67,406 -15,977 84,733 56,753 1 9 2 , 9 1 4 4 6 0 232 273 82.62 -43.49 225.66
2026 42,133 -35,557 92,540 61,802 1 6 0 , 9 1 8 4 7 0 231 272 73.33 -44.49 225.87
2027 49,673 -62,735 97,387 54,244 1 3 8 , 5 6 9 4 8 0 230 271 64.75 -44.00 226.07
2028 -1,044 -31,004 98,592 72,584 1 3 9 , 1 2 8 4 9 0 229 270 56.51 -37.23 225.44
2029 4,407 -68,583 104,052 63,688 1 0 3 , 5 6 4 5 0 0 228 268 65.18 -50.06 226.30
2030 10,969 -74,780 104,340 58,413 9 8 , 9 4 1 5 1 0 227 267 55.90 -50.26 227.15
2031 18,526 -76,110 104,017 54,337 1 0 0 , 7 7 0 5 2 0 226 265 74.01 -37.05 225.31
2032 26,965 -76,070 103,703 51,059 1 0 5 , 6 5 6 5 3 0 225 264 65.76 -28.40 223.14
2033 36,240 -75,431 103,547 48,362 1 1 2 , 7 1 8 5 4 0 224 262 71.89 -40.36 222.51
2034 44,748 -73,375 103,604 46,599 1 2 1 , 5 7 7 5 5 0 223 261 63.31 -41.84 222.10
2035 55,327 -73,107 104,035 44,450 1 3 0 , 7 0 5 5 6 0 222 260 55.06 -43.20 221.90
2036 66,578 -71,764 104,581 42,700 1 4 2 , 0 9 5 5 7 0 221 259 47.19 -44.44 221.90
2037 78,512 -70,080 105,380 41,158 1 5 4 , 9 7 1 5 8 0 220 258 39.72 -45.53 222.09
2038 83,955 -63,309 106,464 42,157 1 6 9 , 2 6 8 5 9 0 219 257 32.69 -46.47 222.45
2039 96,618 -66,016 108,462 39,928 1 7 8 , 9 9 1 6 0 0 218 256 26.14 -47.31 223.00
2040 107,914 -63,235 110,092 39,178 1 9 3 , 9 4 8 6 1 0 217 255 19.90 -48.02 223.71
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This sheet is where the carbon masses of the group of stands specified on the ’Group’ sheet are calculated. A ’group’ of 
stands is a bunch of stands with the same management regime and species (and are thus in the same CAMFor workbook). 
Note the graph below.

This sheet is mainly an output sheet; do not enter anything on this sheet -- except in the light blue cells (name and notes in the 
’Group Description’ table, and the years in the ’Group Carbon Masses in Years of Special Interest’ table). The name and notes 
are optional and have no effect on calculations.

You can change a lot about the appearance of this graph fairly easily. For example, double-click on the axis labels or graph lines 
to edit them. You can also resize, move, copy and paste graphs.
  1. You may want to fiddle with the scales on the graphs. Double-clicking on the numbers of an axis will open the
      ’Format Axis’ dialog box, then choose the ’Scale’ tab. 
  2. You may want to fiddle with the data sources. Select the graph by clicking on it, choose ’Source Data’ from 
      the ’Chart’ menu, the choose the ’Series’ tab. This shows where the data is coming from. It’s an unwieldly 
      interface that only accepts cell references; good luck.
  3. To print, choose a graph by clicking on it once then choose ’Print’ from the ’File’ menu.

This sheet is where the carbon mass increments of the group of stands specified on the ’Group’ sheet are calculated. A 
’group’ of stands is a bunch of stands with the same management regime and species (and are thus in the same CAMFor 
workbook). Note the graph below.

This sheet is mainly an output sheet; do not enter anything on this sheet -- except in the light blue cells (name and notes in the 
’Group Description’ table, and the years in the ’Group Carbon Masses in Years of Special Interest’ table). The name and notes 
are optional and have no effect on calculations.

A ’carbon mass (total)’ is the carbon mass on the site once the stand has started, but is zero before the stand starts. That is, 
the ’carbon mass total’ is the total carbon due to the stand itself and ignores the carbon on a stand site before the stand is 
started.

A ’carbon mass increment’ is the carbon mass on the site less the carbon on the site that was there before the stand was 
started. That is, the ’carbon mass increment’ is the change in non-atmospheric carbon due to planting the stand. The ’carbon 
on the site that was there before the stand was started’ is defined by the initial conditions of the site when the stand was 
started (we assume that the pre-stand carbon on a site is constant, because we don’t know any better).

For example, suppose you have a group with two stands, one planted in 1960 and one planted in 1965. In 1962:
 - The carbon mass total of the group is the carbon on the site in 1962 of the stand planted in 1960 (there is no 
    contribution to the total from the stand yet to be planted).
 - The carbon mass increment of the group is the carbon on the site of the 1960 stand in 1962, less the carbon 
    on the site of the 1960 stand in 1960, plus the carbon on the site of the 1965 stand in 1962 (assumed to be
    as in 1965) less the carbon on the site of the 1965 stand in 1965.

In 1968:
 - The carbon mass total of the group is the carbon on the site of the 1960 stand in 1968, plus the carbon on
    the site of the 1965 stand in 1968.
 - The carbon mass increment of the group is the carbon on the site of the 1960 stand in 1968, less the carbon 
    on the site of the 1960 stand in 1960, plus the carbon on the site of the 1965 stand in 1968, less the carbon 
    on the site of the 1965 stand in 1965.



A ‘carbon mass increment’ is the carbon mass on the site less the carbon on the site that was there before the
stand was started. That is, the ‘carbon mass increment’ is the change in non-atmospheric carbon due to
planting the stand. The ‘carbon on the site that was there before the stand was started’ is defined by the
initial conditions of the site when the stand was started. 

For example, suppose you have a group with two stands, one planted in 1960 and one planted in 1965. 

In 1962:

- The carbon mass total of the group is the carbon on the site in 1962 of the stand planted in 1960
(there is no contribution to the total from the stand yet to be planted).

- The carbon mass increment of the group is the carbon on the site of the 1960 stand in 1962, less the
carbon on the site of the 1960 stand in 1960, plus the carbon on the site of the 1965 stand in 1962
(assumed to be as in 1965) less the carbon on the site of the 1965 stand in 1965.

In 1968:

- The carbon mass total of the group is the carbon on the site of the 1960 stand in 1968, plus the carbon
on the site of the 1965 stand in 1968.

- The carbon mass increment of the group is the carbon on the site of the 1960 stand in 1968, less the
carbon on the site of the 1960 stand in 1960, plus the carbon on the site of the 1965 stand in 1968, less
the carbon on the site of the 1965 stand in 1965.

3.15 APPEARANCE AND CELL SIZE
Always adjust the zoom, not the font or cell sizes. A zoom setting of 75% or 100% is most suitable for most
screen resolutions.

The font and cell sizes in this document are such that everything is efficiently presented, and correctly
formatted. If you adjust some font sizes or some cell sizes then you change the relative sizes and positions of
the various screen elements, and chances are that the document will not look as good. If you want the
writing to be smaller and the information to be denser then choose a lower zoom (typically 50% or 75%); if
you want the writing to be bigger and the information to be more spread out, choose a higher zoom
(typically 100% or 150%).

3.16 CELL PROTECTION
The sheets in this workbook are protected to varying degrees. You need the passwords to be able to make
structural changes to the calculations.

Intro: Protected
In- sheets: All protected, except the light-blue cells (which are used for input data).
Calc- sheets: All protected, except that you may add and delete rows after the first two rows in the ‘Calc-

Sim’ sheet.
Out- sheets: Not protected. Clone and modify as you please.
Stand sheets: All protected, except the light blue cells (which are used for input data), and except that you

may add and delete rows after the first two rows in the ‘Carbon Masses’ tables.
Other sheets: Not protected.
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3.17 ISSUES IN CAMFOR

3.17.1 Uneven Aged Forests
CAMFor can be used to simulate growth in uneven aged forests by adjusting the values in two tables:

1. The “Growth” table, which describes tree growth in terms of current annual increments (CAI’s) in
stem volumes or annual increments in aboveground masses.

2. The “Thinning” table, which describes a harvesting regime - when to thin, how much to thin, how
much to leave in the forest, and how much to remove for milling.

By choosing the values of the two tables together, any growth and thinning scheme can be simulated.

The removal of an age or stem class is a conversion to % of volume of standing stock for the “thinning table”.
The growth would then be expected to revert to a previous point in the curve formed by plotting CAI against
time (presumably to a point of higher CAI) reflecting more robust regrowth in response to disturbance. This
CAI cycle can be imposed over time through the volume based “Growth” table.

3.17.2 Mixed Species
Each CAMFor workbook is constructed to deal with only one management regime and one species at a time,
but even a single CAMFor workbook can simulate a mixed stand if you use weighted averages in its inputs.
This will still provide a robust reflection of “species” and “management regime” characteristics, but care
should be taken if selective harvest changes the species composition (and therefore the weighted averages)
during thinning.

Alternatively, use a CAMFor Estate workbook to add and graph the carbon masses calculated in separate
CAMFor workbooks.

3.17.3 Fire
CAMFor simulates ground fires and or crown-and-ground fires. In a ground fire, a proportion of deadwood
and litter will be combusted (or “decomposed”, with its carbon released to the atmosphere) and a further
proportion will become charcoal and enter the “inert” pool. Branches, stemwood, bark and root are left, and
can be considered to regenerate (lignotubers etc.) or be put as “thinning” (in the case of mortality), with
“bark” entering “litter” and “stemwood” and “branch” as either “deadwood” or “product”. The volume
based “growth table” should be adjusted to account for the impact of the fire. In a crown fire, the leaves and
twigs are combusted and presumed to regrow the following year.
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4. HOW TO USE CAMFOR ESTATE

4.1 CAMFor Estate Sheets

Intro 
Describes the purpose of
CAMFor Estate, development
credits and information about
linking Excel workbooks.

Source X
Provides the means of grouping
the CAMFor workbooks into the
CAMFor Estate workbook.

Estate CM Totals
Sums the carbon masses of
the sources specified in the
Source X sheets to produce an
accumulated carbon mass for a
series of stands (an Estate).

Estate CM Increments
Sums the carbon mass
increments of the sources
specified in the Source X sheets.

4.2 INTRO SHEET
This tab provides basic information and credits for the CAMFor Estate workbook. There is also some general
information about linking workbooks in Excel.

Linking is where one Excel workbook (file) uses results in another workbook. CAMFor Estate links to the
various CAMFor workbooks whose carbon masses it is adding. 

Take special care when dealing with workbooks (such as this one) that link to others, because they can crash
or slow down DRASTICALLY when you rearrange links, or open or save the file. Excel works well when all
the workbooks referenced by a given workbook are open, but if they are closed then you often get
performance problems. So, always open the files that are linked to before the file that links to them.

We recommend:

- Always keep this workbook and all the CAMFor and CAMFor Estate workbooks that it links to in the
same folder (directory).

- Always open the CAMFor and CAMFor Estate workbooks that this workbook is linked to before
saving this workbook or pasting links in this workbook. In particular, open the CAMFor or CAMFor

Estate workbooks that this workbook links to before copying a ‘Group X’ (X = 1,2,3,...) sheet.

- Always open the CAMFor workbooks that this workbook is linked to before opening this workbook. 
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- If, when opening this workbook, Excel asks you if you want to update links, it means that not all the
files that this workbook is linked to are open or are not in the same folder. Say ‘No’, then close this
file, open the files whose data it accesses, then reopen this file.

- Save this file frequently.

- Set your Workbook options (on the ‘Calculation’ tab of the ‘Options’ or ‘Preferences’ in the ‘Tools’
menu) so both ‘Update remote references’ and ‘Save external link values’ are on. 

Initially this file opens to a workbook called ‘CAMFor 335.xls’, so when you opened this file Excel asked
about updating links (unless a file called ‘CAMFor 335.xls’ happened to be open). Go to the ‘Source 1’ sheet
now and change ‘CAMFor 334.xls’ to one of your OPEN CAMFor or CAMFor Estate workbooks.

If you follow these precautions you are unlikely to have any serious problems. Apart from opening and
saving files and pasting links when the referenced file is closed, everything works fine.

4.3 GROUP X (X= 1,2,3,…) SHEET

Source 1

This sheet copies the carbon masses, carbon mass increments, description and statistics from one source;
that source is either the ‘Group CM’ sheet of a CAMFor workbook or the ‘Estate’ sheet of a CAMFor Estate

workbook. Do not move any cells, or delete or insert any rows or columns in this sheet.

Only enter data in the light blue cells, which are all in the ‘multiplier’ column. The purpose of the multiplier
is to mix different stands in varying proportions - for example, you might have two management regimes,
each in its own CAMFor workbook, and want to combine them in a 60:40 ratio some years (multipliers of
0.6 and 0.4, respectively) and 90:10 in other years (multipliers of 0.9 and 0.1, respectively).

The information source for this sheet is shown in the top row of the ‘Group or Estate Description’ table.
This sheet gets its data from that source by including the name of the chosen CAMFor or CAMFor Estate

workbook in its formulae. To choose a different source:

1. Ensure that the source is a CAMFor or CAMFor Estate workbook, that it is in the same folder as this
workbook, and that it is currently open.

2. Select any cell in this sheet, then choose ‘Replace’ from the ‘Edit’ menu. The Replace window
appears. 

3. In the ‘Find What’ box, type in the name of the currently chosen workbook (exactly as it appears in
the ‘Group or Estate Description’ table, no spaces before or after the name). 

4. In the ‘Replace With’ box, type the name of the source file (exact name of the Excel file, with no
spaces before or after). 

5. Ensure that the ‘Find Entire Cells Only’ option is NOT checked. Press the ‘Replace All’ button. 

(Warning: Be sure that the ‘Replace With’ name is correct, because Excel is very ungraceful if you make a
mistake - you will want to escape Excel.) This sheet should now be filled with the data for its source.
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To make new sheets to copy in new sources, copy this sheet exactly as follows:

1. Ensure that the CAMFor workbook referenced by this sheet is currently open in Excel. 

2. Create a new, blank sheet. 

Select any cell in this sheet, then choose ‘Worksheet’ from the ‘Insert’ menu.

3. Move the new, blank sheet to between the ‘Source 1’ and ‘Estate’ sheets.

Grab and drag the tab for the new sheet along the line of tabs at the bottom of the window with
the mouse. 

4. Rename the new, blank sheet to ‘Source X’, where X = 1, 2, 3, ... .

Double click on the name of the sheet in its tab at the bottom of the window and type in the new
name.

5. Copy all the cells in this sheet to the new sheet.

Go to this sheet by clicking on the tab for this sheet at the bottom of the window.

Select all the cells in this sheet by clicking in the grey rectangle at the upper left of the window
where the row and column headers meet. 

Choose ‘Copy’ from the ‘Edit’ menu. 

Go to the new sheet by clicking on its tab at the bottom of the window.

Select cell A1 (upper left) by clicking in it. Choose ‘Paste’ from the edit menu.

6. Change the multiplier values if necessary.

The multipliers will generally be 1, in which case change the top cell in the ‘Multiplier’ column to ‘1’,
select the whole column, and choose ‘Fill:Down’ from the ‘Edit’ menu.

In the new sheet, change the CAMFor workbook it copies from (see above) and change the heading in cell A1
as required.

Important: 

- Each source sheet must be between the ‘Source 1’ sheet and the ‘Estate’ sheet.

- The ‘Source 1’ sheet should never be deleted or renamed.

- We recommend naming the source sheets ‘Source X’, where X = 1, 2, 3, ... .

This sheet may be copied up to 253 times; you can have up to 254 sources in one CAMFor Estate workbook
(usually less due to the limits of your machine’s memory). If limits are reached a simple solution is to make
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an ‘Estate’ of Estates. The same processes can be used for summing CAMFor and CAMFor Estate workbooks.
They can even be mixed in any one peak Estate workbook. Note that when summing ‘Estates’ they should be
saved as the sum of the individual CAMFor workbooks. The CAMFor workbooks can then be closed. This
saves considerable memory usage.

4.4 ESTATE CM TOTALS

This sheet is where we calculate the carbon masses of the sources specified in the ‘Group X’ sheets
(X = 1,2,3,...).

This sheet is mainly an output sheet; do not enter anything on this sheet - except in the light blue cells
(name and notes in the ‘Estate’ table, years in the ‘Carbon Masses in Years of Special Interest’ table). You can
find the carbon masses for a particular year by typing in the year in the ‘Carbon Masses in Years of Special
Interest’ table. The name and notes are optional and have no effect on calculations.

Estate Description

Name Estate Example

Notes Example of an estate.

Estate Statistics

Number of Stands 7

Number of Groups 1

Total Area (ha) 0

Start Year 0

End Year 0

Results Period (y) 0

Estate Carbon Masses Estate Carbon Masses in Years of

Year

Sum of

Source

Multipliers

Carbon Mass in

Trees

Carbon Mass in

Debris

Carbon Mass in

Soil

Carbon Mass in

Products

Total Carbon

Mass in Stand

and Products Year

Row

Index

Carbon Mass in

Trees

yr t t t t t t y r t

Est

Year

Est

TreeCM

Est

DebrCM

Est

SoilCM

Est

PrdCM

0 1.00 0 0 0 0 0000 1980 401 0

1 1.00 0 0 0 0 0000 1995 401 0

2 1.00 0 0 0 0 0000 2000 401 0

3 1.00 0 0 0 0 0000 2008 401 0

4 1.00 0 0 0 0 0000 2009 401 0

5 1.00 0 0 0 0 0000 2010 401 0

6 1.00 0 0 0 0 0000 2011 401 0

Estate

4.5 ESTATE CM INCREMENTS
This sheet is where the carbon mass increments of the sources specified on the ‘Source X’ sheets, X = 1,2,3,... ,
are calculated. Note the graph starting around cell Q43.

This sheet is mainly an output sheet; do not enter anything on this sheet - except in the light blue cells (name
and notes in the ‘Estate Description’ table, and the years in the ‘Group Carbon Masses in Years of Special
Interest’ table). The name and notes are optional and have no effect on calculations.
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5. CALCULATIONS IN CAMFOR

We have developed this model so that you do NOT need a background in computer science to understand
how it works. Although this is a moderately complex model, with a basic understanding of what a
spreadsheet is and a little effort you can figure out exactly how any quantity is calculated. We intend this
model to be understood by non-programmers.

ALL the calculations in the model are implemented as formulae in cells. Thus, you can uncover every single
computation by looking at the formulae in the cells in this workbook. Admittedly there are a lot of cells in
the ‘Calc-Sim’ sheet, but each row is identical to the one above. There is no programming language or macros
used in this model (in particular, there is no use of Visual Basic). Some of the formulae may seem a little
complicated at first, if so, look up the Excel help index regarding the relevant functions (mainly ‘IF’ and
‘INDEX’) and you’ll find them more understandable.

We mainly used names to refer to cells or tables, rather than direct cell references (such as ‘C9’), because:

1. In such a large workbook they are a lot easier to read.

2. They make intersheet communication much more understandable, and make sheets relatively
independent of one another.

5.1 HOW QUANTITIES ARE CALCULATED 
To find out how a quantity is calculated, you need to understand the naming system described in the ‘Doc 2’
sheet. Every quantity is systematically named according to this scheme, and the name is usually written (in
dark green) beside or above the quantity.

We recommend studying the diagrams on the ‘Diagrams’ sheet. These diagrams essentially tell you how all
the calculations are made. For most purposes, you will need to go no further than the naming scheme and
the diagrams. For a bit more detail, consult the calculations notes opposite. For even more detail about how a
quantity is calculated, find where the quantity is calculated or defined:

- If it is defined then it is typed in as a number in one of the input (‘In-’) sheets.

- If it is calculated then it will either be in one of the calculation (‘Calc-’) sheets: 

- If the quantity is calculated on the ‘Calcs-Prelim’ sheet then its computation is a simple matter, so
just look at the formula in its cell. 

- If the quantity is calculated on the ‘Calc-Sim’ sheet then look at the formula in its cell. Names here
usually refer to the cell in the same row in the column with the given name. Consult the Excel help
index as necessary to understand functions such as ‘IF’ or ‘INDEX.’ Consult the diagram to see how
the quantity is formed. Consult the column heading above the name for clues about what the
quantity is and how it is calculated.

Quantities are calculated from other quantities, so you may need to repeat the process just described a
number of times until you relate everything back to quantities defined on the input sheets.
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There is little point in this documentation of describing more precisely how every quantity is calculated,
because: 

1. It would just duplicate the actual calculations, which are only a few clicks away anyway. 

2. In most cases the diagrams are what you want. (We designed the calculations from the diagrams;
the calculations just implement the diagrams.)

5.2 NAMES OF CELLS
Communication between different spreadsheets within this workbook is achieved entirely by named
quantities. Most cells that are named have the name (in green) close by. You can view all the names and
their definitions by choosing ‘Names’ then ‘Define...’ from the ‘Insert’ menu (command-L on a Mac, but
you have to use the menu on a PC).

5.3 SOME CLUES ABOUT HOW THE CALCULATIONS ARE MADE
It would take too much space to describe how every calculation is made. However, here are a few remarks
that might help if you try to figure out how the workbook works.

We compute tree component growth from the increase in stem volume per hectare (defined in the Growth
table in the ‘In-Species’ sheet). We convert this volume increase to a weight increase using the stem density
(basic density). Then we compute the increases in weight of the branches, bark, leaves and roots by their
weight increases relative to stem weight increases (these relativities are also specified in the Growth table).
If you specify growth as increases in aboveground mass in the Growth table, CAMFor simply converts these
to yearly increases in stem volume in the Growth table.

The main calculations are in the ‘Calc-Sim’ sheet. Further comments all refer to this sheet.

The initial conditions are in the first row of the table, year 0. The next row, year 1, contains ALL of the
formulas used by this sheet. All of the remaining rows of this sheet are made by filling down from this row
(use ‘Fill:Down’ in the ‘Edit’ menu), so you can insert and delete rows as you like in this sheet so long as you
leave the year 0 and year 1 rows untouched and fill down from there. It is crucial to note that you can inspect
all of the calculations of this sheet just by inspecting the year 1 row. The chain of causation is strictly top to
bottom, and never looks back further than the previous row.

Each row is either:

1. ‘Normal’

The row calculates growth, decomposition, turnover, breakdown, humification and encapsulation for
the current year. See the first diagram.

2. ‘Thinning’

The row calculates the effects of this year’s thinning, if any. See the second diagram.

3. ‘Fire’ 

The row calculates the effects of this year’s fire, if any. See the third diagram.

Each year has a normal row. If a year has thinning or fire rows then they are always in the order normal then
thinning then fire (as if the thinning or fire occured at the end of the year).
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The ‘Timing, Thinning and Fire’ columns are the most complicated in the workbook. The flow of causality is
left to right, top to bottom, with the exceptions that the ‘Age of Stand’ and ‘Age of Current Rotation’
columns are at the left for greater voisibilty (the former should go after the ‘Last Rows State’ column, while
the latter should be the last column in the section). Only the ‘Clear Last’, ‘Last Rows State’, ‘Age’ and
‘RotAge’ columns from one row are accessed by the next. To track what needs doing in each row, we defined
a state for each row:

4 = Normal row, with thinning and fire rows later that year

3 = Normal row, with thinning row (only) later that year

2 = Normal row, with fire row (only) later that year

1 = Thinning row, with fire row (only) later that year

-1 = Normal row, with no more rows this year

-2 = Thinning row, with no more rows this year

-3 = Fire row, with no more rows this year

The state numbering was chosen to match the Excel conditional statements (there is no particular pattern). 

The ‘Timing, Thinning and Fire’ section is more complex than necessary in order to work around two bugs
in Excel:

1. OR(FALSE, FALSE) = TRUE sometimes. Hence we did not use ‘OR’.

2. AND(TRUE, TRUE) = FALSE sometimes. Hence we did not use ‘AND’.

3. Circular references arise falsely sometimes when you refer to a cell in the same row by the name of
the column containing the cell.

Columns only depend on columns to their left, with a few exceptions. Thus the chain of causation is
generally left to right, and always top to bottom.

‘INDEX(StemVolIncTbl, RotAge, 1)’ is value ‘RotAge’ in table ‘StemVolIncTbl’, that is, the value of the
‘StemVolIncTbl’ table that is indexed by ‘RotAge’. For example, if RotAge = 3 then it is the third value in
StemVolIncTbl (the one for year 3).

‘INDEX(ThinStemDwd, MATCH(RotAge, ThinAge, 0), 1)’ is the value ‘MATCH(RotAge, ThinAge, 0)’ in the
table ‘ThinStemDwd’, and ‘MATCH(RotAge, ThinAge, 0)’ is the row number (or index) of the table ThinAge
that contains (or matches) the value ‘RotAge’. Thus ‘INDEX(ThinStemDwd, MATCH(RotAge, ThinAges, 0),
1)’ is the value in the ‘ThinStemDwd’ table where the thinning age is ‘RotAge’.

There is a column for each material transfer from pool to pool, but not necessarily for other transfers (such as
a CO2 transfer to the atmosphere). The transfer amount is labelled as a decrease in the sending pool, and is
calculated where the sending pool is calculated. The transfer amount is subtracted from the sending pool
and added to the receiving pool. For example, the leaf turnover is calculated in the ‘Tree Masses’ section and
called ‘LeafMDecTurn’ (leaf mass decrease due to turnover), and is subtracted from ‘LeafM’ (leaf mass) and,
after multiplying by carbon fraction ‘CFracLeaf’ and splitting into decomposable and resistant, is added to
DeLLitCM (decomposable leaf litter carbon mass) and ReLLitCM (resistant leaf litter carbon mass).
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APPENDIX A 
DEFINITIONS AND NAMING SYSTEM
The tables below describe:

1. The definitions CAMFor uses to understand the world (the ‘Definition’ column). You need to know
the definitions in order to use CAMFor properly, so please read them.

2. The naming system (the ‘Short Name’ column). You do not need to know the naming system to use
CAMFor, but you do need to know it in order to understand exactly how CAMFor makes its
calculations (just as someone can drive a car without knowing how an internal combusiton engine
works).You should know the definitions here in order to use CAMFor.
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ABBREVIATIONS
You must know these abbreviations to use the model:

DPM = Decomposable plant material

HUM = Humus (in the soil)

RPM = Resistant plant material (resistant to decomposition)

You must know these abbreviations to understand how the model makes its calculations:

The following abbreviations are used in the names of quantities:

Abg = Aboveground (see Blg)

Atm = Atmosphere

Avg = Average = Mean

Blg = Belowground (see Abg)

C = Carbon = Material whose every atom has six protons

CFrac = Carbon fraction = Fraction of the material that is carbon (by weight)

CM = Carbon mass of material = Mass of carbon atoms in the material

Dec = Decrease; positive if quantity decreases (see Inc)

Dens = Density

Frac = Fraction of a specified part of a whole (a number from 0 to 1 inclusive)

Grth = Growth

Inc = Increase; positive if quantity increases (see Dec)

Init = Initial = Value at start of simulated period

Last = Last row’s = of the previous row of the ‘Calc-Sim’ sheet (which often means the last year)

M = Mass (measured as dry weight)

Prev = Previous

Root = Root, usually either a CRoot (coarse root) or FRoot (fine root)

Rot = Rotation

StdR = Stand replacing (a type of fire)

Tbl = Table (omitted if no ambiguity)

Vol = Volume

Wood = Stem, branches, barks, leaves and twigs

Yr = Year
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System

Name Short Name Definition

System Sys Ecosystem consisting of a stand of trees, its products, and
atmospheric carbon exchanged with the stand and its products.

System Components

Name Short Name Definition

Solids Solid Everything in the system that is not in the atmosphere, 
namely the stand of trees and its products.

Atmospheric carbon Atmos Carbon in the atmosphere, considered to be zero before the
stand exists (that is, we only consider the carbon exchanged
with the solids). 

Solids Components

Name Short Name Definition

Stand Std All the tree-related biomass (above and below ground) in a one-
hectare stand of trees. All of the trees in the stand are either of
the same species or can be characterised by a single (same or
weighted averaged) growth table or input parameter set.

Products Prd Products made from the wood harvested from the stand.

Stand Components

Name Short Name Definition

Tree Tree Living tree matter (above and below ground).

Debris Debr Dead organic matter that is not sufficiently decayed to be
considered part of the soil.

Soil Soil Dead organic matter that is sufficiently decayed to be considered
part of the soil. (‘Soil’ here is only the organic matter in the
ground that is associated with the stand - not the minerals and
not the organic matter that is not associated with the stand.)
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Tree Components

Name Short Name Definition

Stem Stem The parts of the trees that are above ground, non-bark,
merchantable (that is, sellable as products to manufacturers),
and large enough to be made into high-value products. 

Branches Bran The parts of the trees that are above ground, non-bark, and
merchantable, and too small to be made into high-value
products.

Stem Bark Bark Bark over stem.

Leaves and Twigs Leaf The non-merchantable parts of the trees where photosynthesis
occurs (leaves) or are fine structures that support the parts of
the tree where photosynthesis occurs (twigs).

Roots Root The parts of the trees that are below ground.

Debris Components

Name Short Name Definition

Decomposable Fine Decay DeFDcy Dead fine roots that haven’t decayed much, and which will
decompose easily.

Resistant Coarse Decay ReFDcy Dead fine roots that haven’t decayed much, but which are
resistant to decomposition.

Decomposable Coarse Decay DeCDcy Dead coarse roots that haven’t decayed much, and which will
decompose easily.

Resistant Coarse Decay ReCDcy Dead coarse roots that haven’t decayed much, but which are
resistant to decomposition.

Decomposable Leaf Litter DeLLit Fallen leaves and twigs that haven’t decayed much, and which
will decompose easily.

Resistant Leaf Litter ReLLit Fallen leaves and twigs that haven’t decayed much, but which
are resistant to decomposition.

Decomposable Bark Litter DeBLit Fallen bark that hasn’t decayed much, and which will
decompose easily.

Resistant Bark Litter ReBLit Fallen bark that hasn’t decayed much, but which is resistant to
decomposition.

Decomposable Deadwood DeDwd Dead stem and branch wood that hasn’t decayed much, and
which will decompose easily.

Resistant Deadwood ReDwd Dead stem and branch wood that hasn’t decayed much, but
which is resistant to decomposition.



Australian Greenhouse Office38

Soil Components

Name Short Name Definition

Active Pool Actv Carbon in the soil that is available to decompose back into the
atmosphere by microbial action (without a major disturbance of
the soil such as ploughing).

Inert Pool Inrt Carbon in the soil that is not in the active pool. This carbon is
mainly either encapsulated by clay (and thus physically
unavailable) or in charcoal (where the carbon is chemically
inaccessible).

Product Components

Name Short Name Definition*

Bio-fuel Fuel Wood used for bio-fuel.

Pulp and paper Papr Paper products.

Packing wood Pack Includes pallets and palings.

Furniture Furn Includes poles and preservatives.

Fibre board Fibr Includes composite board, partcle board, and MDF.

Construction wood Cons Includes framing timber.

Mill Residue Resi Tailings from milling. Includes bark.

* All the wood in a given category returns its carbon to the atmosphere on a similar timescale, which is the
criterion used to determine what category a given product belongs to. The definitions should more properly
be written as ranges of decomposition times.

Movements of Carbon Within the System

Name Short Name Definition and Notes

Growth Grth Growth of trees. Moves carbon from the atmosphere to the tree
components.

Turnover Turn Loss of part of the non-stem tree components to the litter, due to
dropping leaves, twigs, and branches, abandoning roots, and so
on. Moves carbon from the non-stem tree components to the
litter (deadwood in the case of branches). 

Breakdown Bkdn Transformation of debris from its initial state (which is
immediately after it dies and is no longer attached to the tree).
Moves carbon from the debris holding pools (of debris material
that is unavailable to microbes and so on) to the atmosphere, the
active soil pool, or other debris pools.

Decomposition Dcmp Process by which carbon in debris or products is oxidized and
then transferred into the atmosphere. Produces CO2, which is
the gas that causes the greenhouse effect that warms the earth.
Moves carbon from the debris and products to the atmospere.
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Movements of Carbon Within the System (continued)

Name Short Name Definition and Notes

Burning Fire A fire burns (oxidizes) some tree components, thereby destoying
them and transferring most of their carbon to the atmosphere as
CO2 and the rest as charcoal to the inert pool. The ‘Burning’
process here refers to any direct effects of fire. Essentially the
same as decomposition, only faster and with the side effect of
producing charcoal that transfers carbon to the inert pool.
Moves carbon from the trees, debris and products to the
atmosphere or inert pool.

Humification Humf Processing of litter into humus, typically by insects that
physically transport the material into the soil. Moves carbon
from the debris to the active pool in the soil.

Encapsulation Encp Formation of inert material from active material by smoothering
in clay. Moves carbon from the active pool to the inert pool.

Thinning Thin Conversion of stem wood to deadwood or products and the
accompanying harvest slash converts bark, branches, and leaves
and twigs into deadwood and litter. Also called ‘harvesting’. A
‘100% thin’ removes all of the stem wood in the stand. Moves
carbon from the stems to products and deadwood.

Removal Remv Removal of carbon from the atmosphere. Any movement of
carbon from the atmosphere into the trees.

Emission Emit Emission of carbon to the atmosphere. Any movement of carbon
from the trees, debris, soil or products into the atmosphere.

Time

Name Short Name Definition and Notes

Year Year Unit of time. The model simulates from 0 years to several
hundred years, in one year steps.

Age Age The age of the trees in the stand that were planted at the
beginning of the current rotation (in years).

Rotation Rot A rotation is all that happens from the initial planting of trees in
the stand to when the stand is next 100% thinned (including the
effects of a stand replacing fire).

Units

Name Short Name Definition

hectare ha 10,000 square metres, about 2.471054 acres

kilogram kg 1,000 g, about 2.204623 pounds

tonne t 1,000 kg = 1,000,000 g, about 0.9842065 (US long) tons

year yr

cubic metre m3 or m3 About 1.307950619 cubic yards
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Preliminary Calculations

Name Calculated As… Units

BasicDens Density of stem wood, using tonnes 
(because tonnes are used for every mass in the model).

BasicDens = BasicDensKg / 1000 t / ha

StdPrdCMInit Initial carbon mass of stand and products.
StdPrdCMInit = StemVolInit * BasicDens * CFracStem + 
BranMInit * CFracBran + BarkMInit * CFracBark + LeafMInit * 
CFracLeaf + CRootMInit * CFracCRoot + FRootMInit * 
CFracFRoot + DeFDcyCMInit + ReFDcyCMInit + DeCDcyCMInit + 
ReCDcyCMInit + DeLLitCMInit + ReLLitCMInit + DeBLitCMInit + 
ReBLitCMInit + DeDwdCMInit + ReDwdCMInit + ActvCMInit + 
InrtCMInit t / ha

Managed Stand managed by people?

Managed = Is ManagedInput equal to “Managed”? -

ReFracStem Resistant fraction of stems 
(similarly for branches, bark, leaf, coarse root and fine root).

ReFracStem = 1 – DeFracStem -

FracGasDeFDcyBkdn Gas fraction of breakdown carbon (fraction of broken-down carbon 
that is gas, by mass) for decomposable fine decay (similarly for the 
other nine debris types).

FracGasDeFDcyBkdn = RatioGasDeFDcyBkdn / 
(1 + RatioGasDeFDcyBkdn) -

FracSoildDeFDcyBkdn Solid fraction of breakdown carbon 
(fraction of broken-down carbon that is solid, by mass) 
for decomposable fine decay 
(similarly for the other nine debris types).

FracSoildDeFDcyBkdn = 1 – FracGasDeFDcyBkdn -

FracGasDeFDcyBurn Gas fraction of burning carbon 
(fraction of burnt carbon that is gas, by mass) 
for decomposable fine decay 
(similarly for the other nine debris types).

FracGasDeFDcyBurn = RatioGasDeFDcyFire / 
(1 + RatioGasDeFDcyFire) -

FracSolidDeFDcyBurn Solid fraction of burning carbon 
(fraction of burnt carbon that is solid, by mass) 
for decomposable fine decay 
(similarly for the other nine debris types).

FracSoildDeFDcyBurn = 1 – FracGasDeFDcyBurn -

Timing, Thinning and Fire

Name Calculated As… Units

Year Year of the simulation, that is, the number of years since the 
simulated period started. Equal to the Year in the previous row 
plus one, except if this is a fire or thinning row in which case it is 
equal to the Year of the previous row. yr

RotAgeProper The age of the current rotation (that is, the age of the trees that 
were planted at the beginning of the current rotation) at the end of 
the row. Equal to RotAge, except that it is zero if the stand was 
cleared that year. yr
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Timing, Thinning and Fire (continued)

Name Calculated As… Units

ClearLast Copy of Clear from the previous row.

StateLast Copy of State from the previous row.

RotAge The age of the current rotation (that is, the age of the trees that 
were planted at the beginning of the current rotation) at the end of
the row, but ignoring the effect of the row itself (which might clear 
the stand and thereby reset the rotation age to zero). Equal to the 
RotAge in the previous row plus one, except if this is a fire or 
thinning row in which case it is equal to the RotAge of the previous 
row, or except that it is reset to 1 if the stand was cleared in the 
previous year.

ThinYear TRUE if and only if there is a scheduled thin this year (does not 
include a thin that is prompted by a stand-replacing fire).

Fire TRUE if and only if there is a fire this year.

State The state of the rows. See the ‘Some Clues About How the 
Calculations are Made’ text box opposite for what the numbers 
mean. If State < 0 then start a new year in the next row.

NormRow TRUE if and only if the spreadsheet row is a normal row 
(implements all processes for the year except for thinning and fire). 
Computed from the State.

ThinRow TRUE if and only if the spreadsheet row is a thinning row. 
Computed from the State.

FireRow TRUE if and only if the spreadsheet row is a fire row. Computed 
from the State.

FireIndex Row number (or index) of the row in the Fire table for this year, or 
blank if there is no such row.

StdRFire TRUE if and only if the spreadsheet row is a fire row and the fire 
is a stand-replacing fire. Looks up the fire table.

CrwnFire TRUE if and only if the spreadsheet row is a fire row and the fire 
is a stand-replacing fire or crown-and-ground regenerating fire. 
Looks up the fire table.

ThinIndex Row number (or index) of the row in the Thinning table for this 
rotation age, or blank if there is no such row.

ThinFrac The fraction of trees thinned, either by a regular thinning or as the
aftermath of a stand-replacing fire. Computed from thinning table
and StdRFire.

Clear TRUE if and only if this is the last row for the year and that year the 
stand was cleared (for any reason).
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Tree Masses

Name Calculated As… Units

BasicMIncGrth Basic mass increase due to growth (used to calculate mass increases 
due to growth of all of the tree masses).

BasicMIncGrth = StemVolIncTbl(RotAge) * BasicDens t / ha

StemMIncGrth Stem mass increase due to growth.

StemMIncGrth = BasicMIncGrth * SiteAdjustStem t / ha

BranMIncGrth Branch mass increase due to growth.

BranMIncGrth = BasicMIncGrth * BranMIncTbl(RotAge) *
SiteAdjustBran + BranMDecTurn t / ha

BarkMIncGrth Bark mass increase due to growth.

BarkMIncGrth = BasicMIncGrth * BarkMIncTbl(RotAge) * 
SiteAdjustBark + BarkMDecTurn t / ha

LeafMIncGrth Leaf and twig mass increase due to growth.

LeafMIncGrth = BasicMIncGrth * LeafMIncTbl(RotAge) * 
SiteAdjustLeaf + LeafMDecTurn t / ha

CRootMIncGrth Coarse root mass increase due to growth.

CRootMIncGrth = BasicMIncGrth * CRootMIncTbl(RotAge) * 
SiteAdjustCRoot + CRootMDecTurn t / ha

FRootMIncGrth Fine root mass increase due to growth.

FRootMIncGrth = BasicMIncGrth * FRootMIncTbl(RotAge) * 
SiteAdjustFRoot + FRootMDecTurn t / ha

BranMDecTurn Branch mass decrease due to turnover.

BranMDecTurn = BranTurnFrac * BranM t / ha

BarkMDecTurn Bark mass decrease due to turnover.

BarkMDecTurn = BarkTurnFrac * BarkM t / ha

LeafMDecTurn Leaf and twig mass decrease due to turnover.

LeafMDecTurn = LeafTurnFrac * LeafM t / ha

CRootMDecTurn Coarse root mass decrease due to turnover.

CrootMDecTurn = CRootTurnFrac * CRootM t / ha

FRootMDecTurn Fine root mass decrease due to turnover.

FrootMDecTurn = FRootTurnFrac * FRootM t / ha

StemMDecThin Stem mass decrease due to thinning.

StemMDecThin = ThinFrac * StemM t / ha

BranMDecThin Branch mass decrease due to thinning.

BranMDecThin = ThinFrac * BranM t / ha

BarkMDecThin Bark mass decrease due to thinning.

BarkMDecThin = ThinFrac * BarkM t / ha

LeafMDecThin Leaf and twig mass decrease due to thinning.

LeafMDecThin = ThinFrac * LeafM t / ha

CRootMDecThin Coarse root mass decrease due to thinning.

CrootMDecThin = ThinFrac * CRootM t / ha

FRootMDecThin Fine root mass decrease due to thinning.

FrootMDecThin = ThinFrac * CRootM t / ha

StemMDecBurnAtm Stem mass decrease due to fire (goes up in smoke).
StemMDecBurnAtm = FireGasFrac(Year) * StemM t / ha



National Carbon Accounting System Technical Report 43

Tree Masses (continued)

Name Calculated As… Units

BranMDecBurnAtm Branch mass decrease due to fire (goes up in smoke).

BranMDecBurnAtm = FireGasFrac(Year) * BranM t / ha

BarkMDecBurnAtm Bark mass decrease due to fire (goes up in smoke).

BarkMDecBurnAtm = FireGasFrac(Year) * BarkM t / ha

LeafMDecBurnAtm Leaf and twig mass decrease due to fire (goes up in smoke).

LeafMDecBurnAtm = LeafM t / ha

StemMDecBurnDebr Stem mass decrease due to fire (falls into debris).

StemMDecBurnDebr = FireDebrFrac(Year) * StemM t / ha

BranMDecBurnDebr Branch mass decrease due to fire (falls into debris).

BranMDecBurnDebr = FireDebrFrac(Year) * BranM t / ha

BarkMDecBurnDebr Bark mass decrease due to fire (falls into debris).

BarkMDecBurnDebr = FireDebrFrac(Year) * BarkM t / ha

StemM Stem mass.

StemM = StemM + StemMIncGrth – StemMDecThin – 
StemMDecBurnAtm – StemMDecBurnDebr t / ha

BranM Branch mass.

BranM = BranM + BranMIncGrth – BranMDecTurn – 
BranMDecThin – BranMDecBurnAtm – BranMDecBurnDebr t / ha

BarkM Bark mass.

BarkM = BarkM + BarkMIncGrth – BarkMDecTurn – 
BarkMDecThin – BarkMDecBurnAtm – BarkMDecBurnDebr t / ha

LeafM Leaf and twig mass.

LeafM = LeafM + LeafMIncGrth – LeafMDecTurn – 
LeafMDecThin – LeafMDecBurnAtm t / ha

CRootM Coarse root mass.

CRootM = CRootMLast + CRootMIncGrth – CRootMDecTurn – 
CRootMDecThin t / ha

FRootM Fine root mass.

FRootM = FRootMLast + FRootMIncGrth – FRootMDecTurn – 
FRootMDecThin t / ha

TreeM Tree mass.

TreeM = StemM + BranM + BarkM + LeafM + CRootM + FRootM t / ha

TreeMIncGrth Tree mass increase due to growth.

= StemMIncGrth + BranMIncGrth + BarkMIncGrth + 
LeafMIncGrth + CRootMIncGrth + FRootMIncGrth t / ha

TreeMDecTurn Tree mass decrease due to turnover.

= BranMDecTurn + BarkMDecTurn + LeafMDecTurn + 
CRootMDecTurn + FRootMDecTurn t / ha

TreeCM Tree carbon mass.

TreeM = CFracStem * StemM + CFracBran * BranM + CFracBark *
BarkM + CFracLeaf * LeafM + CFracCRoot * CRootM + 
CFracFRoot * FRootM t / ha
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Stem Volume

Name Calculated As… Units

StemVol Stem volume.

StemVol = StemM / BasicDens m3 / ha

StemVolGrthRot Stem volume increase due to growth, from the beginning of the 
current rotation to now.

StemVolGrthRot = StemVolGrthRot + StemMIncGrth / BasicDens m3 / ha

StemVolThinRot Stem volume decrease due to thinning, from the beginning of the 
current rotation to now.

StemVolThinRot = StemVolThinRot + StemVolDecThin m3 / ha

StemVolIncGrthAvg Average of the yearly stem volume increases due to growth, from 
the beginning of the current rotation to now. 
StemVolIncGrthAvg = StemVolGrthRot / RotAge m3 / ha

Debris Masses

Name Calculated As… Units

DeFDcyCMDecBkdn Decomposable fine decay carbon mass decrease due to breakdown. 
Similarly for the other nine debris types.

DeFDcyCMDecBkdn = DeFDcyCM * BkdnFracDeFDcy t / ha

DeFDcyCMDecBurn Decomposable fine decay carbon mass decrease due to burning. 
Similarly for the other nine debris types.

DeFDcyCMDecBurn = DeFDcyCM * FireFracDeFDcy(Year) t / ha

DeFDcyCM Decomposable fine decay carbon mass.

DeFDcyCM = DeFDcyCM + (FRootMDecTurn + FRootMDecThin) 
* CFracFRoot * DeFracFRoot – DeFDcyCMDecBkdn – 
DeFDcyCMDecBurn t / ha

ReFDcyCM Resistant fine decay carbon mass.

ReFDcyCM = ReFDcyCM + (FRootMDecTurn + FRootMDecThin) * 
CFracFRoot * ReFracFRoot – ReFDcyCMDecBkdn – 
ReFDcyCMDecBurn t / ha

DeCDcyCM Decomposable coarse decay carbon mass.

DeCDcyCM = DeCDcyCM + (CRootMDecTurn + CRootMDecThin) * 
CFracCRoot * DeFracCRoot – DeCDcyCMDecBkdn – 
DeCDcyCMDecBurn t / ha

ReCDcyCM Resistant coarse decay carbon mass.

ReCDcyCM = ReCDcyCM + (CRootMDecTurn + CRootMDecThin) * 
CFracCRoot * ReFracCRoot – ReCDcyCMDecBkdn – 
ReCDcyCMDecBurn t / ha

DeLLitCM Decomposable leaf litter carbon mass.

DeLLitCM = DeLLitCM + (LeafMDecTurn + LeafMDecThin) * 
CFracLeaf * DeFracLeaf – DeLLitCMDecBkdn – DeLLitCMDecBurn t / ha

ReLLitCM Resistant leaf litter carbon mass.

ReLLitCM = ReLLitCM + (LeafMDecTurn + LeafMDecThin) * 
CFracLeaf * ReFracLeaf – ReLLitCMDecBkdn – ReLLitCMDecBurn t / ha
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Debris Masses (continued)

Name Calculated As… Units

DeBLitCM Decomposable bark litter carbon mass.

DeBLitCM = DeBLitCM + (BarkMDecTurn + BarkMDecThin *
ThinBarkLit(ThinIndex) + BarkMDecBurnDebr) * CFracBark * 
DeFracBark – DeBLitCMDecBkdn – DeBLitCMDecBurn t / ha

ReBLitCM Resistant bark litter carbon mass.

ReBLitCM = ReBLitCM + (BarkMDecTurn + BarkMDecThin *
ThinBarkLit(ThinIndex) + BarkMDecBurnDebr) * CFracBark * 
ReFracBark – ReBLitCMDecBkdn – ReBLitCMDecBurn t / ha

DeDwdCM Decomposable deadwood carbon mass.

DeBLitCM = DeDwdCM + (BranMDecTurn + BranMDecThin *
ThinBranDwd(ThinIndex) + BranMDecBurnDebr) * CFracBran * 
DeFracBran + (StemMDecThin * ThinStemDwd(ThinIndex) + 
StemMDecBurnDebr) * CFracStem * DeFracStem – 
DeDwdCMDecBkdn – DeDwdCMDecBurn t / ha

ReDwdCM Resistant deadwood carbon mass.

ReBLitCM = ReDwdCM + (BranMDecTurn + BranMDecThin *
ThinBranDwd(ThinIndex) + BranMDecBurnDebr) * CFracBran * 
ReFracBran + (StemMDecThin * ThinStemDwd(ThinIndex) + 
StemMDecBurnDebr) * CFracStem * ReFracStem – 
ReDwdCMDecBkdn – ReDwdCMDecBurn t / ha

DebrCM Debris carbon mass.

DebrCM = DeFDcyCM + ReFDcyCM + DeCDcyCM + 
ReCDcyCM + DeLLitCM + ReLLitCM + DeBLitCM + 
ReBLitCM + DeDwdCM + ReDwdCM t / ha

DebrDPM Carbon mass of material leaving debris as DPM.

DebrDPM = DeFDcyCMDecBkdn * FracSolidDeFDcyBkdn + 
DeCDcyCMDecBkdn * FracSolidDeCDcyBkdn t / ha

DebrRPM Carbon mass of material leaving debris as RPM.

DebrRPM = ReFDcyCMDecBkdn * FracSolidReFDcyBkdn + 
ReCDcyCMDecBkdn * FracSolidReCDcyBkdn t / ha

DebrHUM Carbon mass of material leaving debris as humus.

DebrHUM = DeLLitCMDecBkdn * FracSolidDeLLitBkdn + 
ReLLitCMDecBkdn * FracSolidReLLitBkdn + DeBLitCMDecBkdn *
FracSolidDeBLitBkdn + ReBLitCMDecBkdn * 
FracSolidReBLitBkdn + DeDwdCMDecBkdn * 
FracSolidDeDwdBkdn + ReDwdCMDecBkdn * 
FracSolidReDwdBkdn t / ha
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Soil Masses

Name Calculated As… Units

ActvCMDecEncp Active carbon mass decrease due to encapsulation.

ActvCMDecEncp = EncpFracActv * ActvCM t / ha

ActvCM Carbon mass of the active soil pool.

ActvCM = ActvCM + DebrDPM + DebrRPM + DebrHUM – 
ActvCMDecEncp – DcmpFracActv * ActvCMLast t / ha

InrtCM Carbon mass of the inert soil pool.

InrtCM = InrtM + ActvCMDecEncp + DeFDcyCMDecBurn * 
FracSolidDeFDcyBurn + ReFDcyCMDecBurn * 
FracSolidReFDcyBurn + DeCDcyCMDecBurn * 
FracSolidDeCDcyBurn + ReCDcyCMDecBurn * 
FracSolidReCDcyBurn + DeLLitCMDecBurn * 
FracSolidDeLLitBurn + ReLLitCMDecBurn * 
FracSolidReLLitBurn + DeBLitCMDecBurn * 
FracSolidDeBLitBurn + ReBLitCMDecBurn * FracSolidReBLitBurn +
DeDwdCMDecBurn * FracSolidDeDwdBurn + ReDwdCMDecBurn *
FracSolidReDwdBurn t / ha

SoilCM Soil carbon mass.

SoilCM = ActvCM + InrtCM t / ha

Product Masses

Name Calculated As… Units

FuelCM Bio-fuel carbon mass.

FuelCM = FuelCM – DcmpFracFuel * FuelCM + 
ThinStemFuel(ThinIndex) * StemMDecThin * CFracStem +
ThinBranFuel(ThinIndex) * BranMDecThin * CFracBran + 
ThinBarkFuel(ThinIndex) * BarkMDecThin * CFracBark t / ha

PaprCM Pulp and paper carbon mass.

PaprCM = PaprCM – DcmpFracPapr * PaprCM + 
ThinStemPapr(ThinIndex) * StemMDecThin * CFracStem +
ThinBranPapr(ThinIndex) * BranMDecThin * CFracBran +
ThinBarkPapr(ThinIndex) * BarkMDecThin * CFracBark t / ha

PackCM Packing wood and furniture carbon mass.

PackCM = PackCM – DcmpFracPack * PackCM + 
ThinStemPack(ThinIndex) * StemMDecThin * CFracStem +
ThinBranPack(ThinIndex) * BranMDecThin * CFracBran t / ha

FurnCM Furniture carbon mass.

FurnCM = FurnCM – DcmpFracFurn * FurnCM + 
ThinStemFurn(ThinIndex) * StemMDecThin * CFracStem +
ThinBranFurn(ThinIndex) * BranMDecThin * CFracBran t / ha

FibrCM Fibre board carbon mass.

FibrCM = FibrCM – DcmpFracFibr * FibrCM + 
ThinStemFibr(ThinIndex) * StemMDecThin * CFracStem + 
ThinBranFibr(ThinIndex) * BranMDecThin * CFracBran t / ha

ConsCM Construction wood carbon mass.

ConsCM = ConsCM – DcmpFracCons * ConsCMLast + 
ThinStemCons(ThinIndex) * StemMDecThin * CFracStem +
ThinBranCons(ThinIndex) * BranMDecThin * CFracBran t / ha
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Product Masses (continued)

Name Calculated As… Units

ResiCM Mill residue carbon mass.

ResiCM = ResiCM – DcmpFracResi * ResiCMLast + 
ThinStemResi(ThinIndex) * StemMDecThin * CFracStem +
ThinBranResi(ThinIndex) * BranMDecThin * CFracBran + 
ThinBarkResi(ThinIndex) * BarkMDecThin * CFracBark t / ha

PrdCM Products carbon mass.

PrdCM = FuelCM + PaprCM + PackCM + FurnCM + FibrCM + 
ConsCM + ResiCM t / ha

Carbon Exchanges with the Atmosphere

Name Calculated As… Units

CMFixTreeGrth Carbon mass fixed by trees, due to growth.

CMFixTreeGrth = CFracMain * (StemMIncGrth + BranMIncGrth) + 
CFracLit * (BarkMIncGrth + LeafMIncGrth) + CFracDcy * 
RootMIncGrth t / ha

CMRelTreeFire Carbon mass released by trees, due to fire.

CMRelTreeFire = CFracLit * LeafMDecFire t / ha

CMRelDebrFire Carbon mass released by debris, due to fire.

CMRelDebrFire = CFracMain * DwdMDecFire + CFracLit * 
LitMDecFire + CFracDcy * DcyMDecFire t / ha

CMRelDebrFire Carbon mass released by debris due to decomposition. 

CMRelDebrDcmp = CFracMain * DwdMDecDcmp + CFracLit * 
LitMDecDcmp + CFracDcy * DcyMDecDcmp t / ha

CMRelSoilDcmp Carbon mass released by soil due to decomposition.

CMRelSoilDcmp = CFracHum * HumMDecDcmp t / ha

CMRelPrdDcmp Carbon mass released by products due to decomposition. 

CMRelPrdDcmp = CFracMain * PrdMDecDcmp t / ha

CMFixStd Carbon mass fixed by the stand.

CMFixStd = CMFixTreeGrth – CMRelTreeFire – CMRelDebrFire – 
CMRelDebrDcmp – CMRelSoilDcmp t / ha

CMFixSolid Carbon mass fixed by the solids.

CMFixSolid = CMFixStd – CMRelPrdDcmp t / ha
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Carbon Masses

Name Calculated As… Units

CMRemvTreeGrth Carbon mass removed by trees due to growth.

CMRemvTreeGrth = CFracStem * StemMIncGrth + CFracBran * 
BranMIncGrth + CFracBark * BarkMIncGrth + CFracLeaf * 
LeafMIncGrth + CFracCRoot * CRootMIncGrth + CFracFRoot * 
FRootMIncGrth t / ha

CMEmitDebrDcmp Carbon mass emitted by debris due to breakdown.

CMEmitDebrDcmp = DeFDcyCMDecBkdn * 
FracGasDeFDcyBkdn + ReFDcyCMDecBkdn * 
FracGasReFDcyBkdn + DeCDcyCMDecBkdn * 
FracGasDeCDcyBkdn + ReCDcyCMDecBkdn * 
FracGasReCDcyBkdn + DeLLitCMDecBkdn * 
FracGasDeLLitBkdn + ReLLitCMDecBkdn * FracGasReLLitBkdn +
DeBLitCMDecBkdn * FracGasDeBLitBkdn + ReBLitCMDecBkdn *
FracGasReBLitBkdn + DeDwdCMDecBkdn * 
FracGasDeDwdBkdn + ReDwdCMDecBkdn * FracGasReDwdBkdn t / ha

CMEmitSoilDcmp Carbon mass emitted by soil due to decomposition.

CMEmitSoilDcmp = DcmpFracActv * ActvCMLast t / ha

CMEmitPrdDcmp Carbon mass emitted by products due to decomposition.

CMEmitPrdDcmp = DcmpFracFuel * FuelCMLast + 
DcmpFracPapr * PaprCMLast + DcmpFracPack * PackCMLast + 
DcmpFracFurn * FurnCMLast + DcmpFracFibr * FibrCMLast + 
DcmpFracCons * ConsCMLast + DcmpFracResi * ResiCMLast t / ha

CMEmitTreeFire Carbon mass emitted by trees due to burning.

CMEmitTreeFire = StemMDecBurnAtm * CFracStem + 
BranMDecBurnAtm * CFracBran + BarkMDecBurnAtm * 
CFracBark + LeafMDecBurnAtm * CFracLeaf t / ha

CMEmitDebrFire Carbon mass enitted by debris due to burning. 

CMEmitDebrFire = DeFDcyCMDecBurn * FracGasDeFDcyBurn +
ReFDcyCMDecBurn * FracGasReFDcyBurn + 
DeCDcyCMDecBurn * FracGasDeCDcyBurn + 
ReCDcyCMDecBurn * FracGasReCDcyBurn + 
DeLLitCMDecBurn * FracGasDeLLitBurn + ReLLitCMDecBurn *
FracGasReLLitBurn + DeBLitCMDecBurn * FracGasDeBLitBurn +
ReBLitCMDecBurn * FracGasReBLitBurn + DeDwdCMDecBurn *
FracGasDeDwdBurn + ReDwdCMDecBurn * 
FracGasReDwdBurn t / ha

CMRemvStd Total, net carbon mass removed by the stand 
(does not include carbon emitted by products not the products).

CMRemvStd = CMRemvTreeGrth – CMEmitDebrDcmp – 
CMEmitSoilDcmp – CMEmitTreeFire – CMEmitDebrFire t / ha

CMRemvStdPrd Total, net carbon mass removed by the stand and the products, 
which is the total net carbon removed from the atmosphere as a 
result of the stand - this row.

CMRemvStdPrd = CMRemvStd – CMEmitPrdDcmp t / ha

CMRemvToDate Total, net carbon mass removed by the stand and the products 
(removed from the atmosphere) - to date, from beginning of 
simulated period.

CMRemvToDate = (value from previous row) + CMRemvStdPrd t / ha
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Aggregates

Name Calculated As… Units

StemCM Carbon mass of stems.

StemCM = CFracStem * StemM t / ha

StdCM Carbon mass of stand.

StdCM = TreeCM + DebrCM + SoilCM t / ha

StdPrdCM Carbon mass of stand and products.

StdPrdCM = StdCM + PrdCM t / ha

FracCMTotalInPrd Fraction of carbon mass in stand and products that is in products

FracCMTotalInPrd = PrdCM / StdPrdCM -
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